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DARKADAPTED SOFTWARE LICENSE

Before opening DarkAdapted, carefully read the following License Agreement. Opening DarkAdapted indicates your acceptance of the terms and conditions of this Agreement. If you do not
agree to abide by the terms and conditions of this Agreement, promptly return the product to the place of purchase, and your money will be refunded.

A. License. The software accompanying this License (the “Software”) and the related documentation are licensed to you by Stephen E. Hutson. You own the media on which the Software is
recorded, if applicable, but Stephen E. Hutson retains title to the Software and all related documentation.

This License allows you to use the Software on a single computer and make up to ten (10) copies of the Software in machine-readable form for backup purposes only. You must reproduce on
such copy the copyright notice and any other proprietary legends that were on the original copy of the Software. You may transfer all your license rights in the Software, the backup copies of
the Software, the related documentation and a copy of this License to another party, provided the other party reads and agrees to accept the terms and conditions of this License, and provided
you destroy all copies of the Software in your possession prior to license transfer.

B. Restrictions. The Software contains copyrighted material, trade secrets, and other proprietary material, and in order to protect them, you may not decompile, reverse engineer, disassemble, or
otherwise reduce the Software to a human-perceivable form. You may not modify, network, rent, lease, loan, distribute, or create derivative works based upon the Software in whole or in part.
You may not electronically transmit the Software from one computer to another over a network.

C.Termination. This License is effective until terminated. You may terminate this License at any time by destroying the Software and related documentation and all copies thereof. This License
will terminate immediately without notice from Stephen E. Hutson if you fail to comply with any provision of this License. Upon termination, you must destroy the Software and related
documentation and all copies thereof.

D. Exporting. You agree and certify that the Software, its related documentation, nor any copies thereof will be exported outside of the United States except as authorized and as permitted by
the laws and regulations of the United States of America.

E. Limited Warranty on Media. Stephen E. Hutson warrants the media on which the Software is recorded, if applicable, to be free from defects in materials and workmanship under normal
use for a period of ninety (90) days from the date of purchase as evidenced by a copy of the receipt. Stephen E. Hutson’s entire liability and exclusive remedy will be the replacement of the
media not meeting this limited warranty and which are returned to Stephen E. Hutson with a copy of the receipt. Stephen E. Hutson will have no responsibility to replace media damaged
by accident, abuse, or misapplication. ANY IMPLIED WARRANTIES ON THE MEDIA, INCLUDING THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-
INFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE, ARE LIMITED IN DURATION TO NINETY (90) DAYS FROM THE DATE OF DELIVERY. THIS
WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY BY JURISDICTION.

F. Disclaimer of Warranty of Software. You expressly acknowledge and agree that use of the Software is at your sole risk. THE SOFTWARE AND RELATED DOCUMENTATION
ARE PROVIDED “AS IS” AND WITHOUT WARRANTY OF ANY KIND AND STEPHEN E. HUTSON EXPRESSLY DISCLAIMS ALL WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT, AND FITNESS FOR A PAR-
TICULAR PURPOSE. STEPHEN E. HUTSON DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET YOUR REQUIRE-
MENTS, OR THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE SOFTWARE WILL
BE CORRECTED. FURTHERMORE, STEPHEN E. HUTSON DOES NOT WARRANT OR MAKE ANY REPRESENTATIONS REGARDING THE USE OF THE
SOFTWARE OR RELATED DOCUMENTATION IN TERMS OF THEIR CORRECTNESS, ACCURACY, RELIABILITY, OR OTHERWISE. NO ORAL OR WRITTEN
ADVICE OR INFORMATION GIVEN BY STEPHEN E. HUTSON OR ITS REPRESENTATIVE SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE
SCOPE OF THIS WARRANTY. SHOULD THE SOFTWARE PROVE DEFECTIVE, YOU ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR,
OR CORRECTION. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY
TO YOU.

G. Limitation of Liability. UNDER NO CIRCUMSTANCES, INCLUDING NEGLIGENCE, SHALL STEPHEN E. HUTSON OR ITS DIRECTORS, OFFICERS, EMPLOY-
EES, OR AGENTS, BE LIABLE FOR ANY INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES THAT RESULT FROM THE USE OR INABILITY TO USE
THE SOFTWARE OR RELATED DOCUMENTATION, EVEN IF IT HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. SOME JURISDICTIONS
DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR
EXCLUSION MAY NOT APPLY TO YOU.

In no event shall Stephen E. Hutson’s total liability to you for all damages, losses, and causes of action (whether in contract, tort [including negligence], or otherwise) exceed the amount paid
by you for the Software.

H. Controlling Law and Severability. This License shall be governed by and construed in accordance with the laws of the United States and the State of Illinos.
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S e CtiOn 1: * Control console “remembers” its position on your screen in both its
: minimized and maximized modes.

IntrOd uct|on * Saved gamma preset is restored when DarkAdapted is launched, and
reset when DarkAdapted quits.
DarkAdapted can dim your screen to the point that it becomes * Usetul display featt‘lres show gamma changes’ effects on selected text,
& unreadable! If this occurs, the default escape sequence on a as well as text on dlfferent.backgrounds.
Macintosh is (3 command [y shit][Rerurn]. On Windows, it is * Useful numeric %nd graphical readouts of gamma values'. ‘
. This will return your screen to full brightness. *In ‘mult1p1e monitor setups, DarkAdapted controls all displays in
unison.
1.1 — License Agreement * Automatic and/or manual Internet update checking ensures you have

the latest version.
Before using DarkAdapted, carefully read the enclosed Software License  + And many other time savers and productivity enhancers.
Agreement. If you do not agree Wlth_ any provision of this agreement, do not Additional features available in DarkAdapted Pro (available for Macintosh
use DarkAdapted, and delete all copies of the program. Using DarkAdapted only) include:

indicates your acceptance of the Software License Agreement.
* System-wide Status Item Menu offers control of virtually every

DarkAdapted setting.
* System-wide hotkeys allow setting brightness, gamma values, presets,
and much more via a customizable key combination.

— i ?
1.2 — What is DarkAdapted? * Global hotkeys for adjusting screen brightness.

DarkAdapted is a gamma control application program. It modifies the red,  *Independent control windows for multiple display setups.
green, and blue components of your screen gamma so that you may, for ~ * Scheduled gamma fades by day of week, time, and/or sunrise and

DarkAdapted is freeware, but remains a copyrighted program. Distribution
of DarkAdapted must include this User Guide and all other documentation.

example, preserve your dark adaptation while using your computer. sunset. '
DarkAdapted boasts such features as: Szges(lill;lsei AppleScript execution by day of week, time, and/or sunrise
* Includes the same powerful screen adjustment technology as * Preset Sets, which can implement gamma fades for multiple screens
ScopeDriver, a full featured telescope control program. simultaneously with a single command or hotkey.
* Customizable gamma presets. Use predefined settings, create your * Run AppleScripts from the system-wide menu, or at the touch of a
own, and manipulate your presets with ease. hotkey.
* High-resolution sliders allow you to adjust red, green, and blue video * Automatic launch at login for one or all users.
components individually and in real time. * Shared or individual preferences for all users.
* Set red, green, and blue video components via the keyboard, and * Define a minimum brightness for all displays.
toggle between entering percentages and raw gamma values. * Scroll wheel support for slider motion and Presezs: pop-up menu.
* Small screen mode hides advanced controls, minimizing the use of * Expanded AppleScript support.
valuable screen real estate. * And much more!

* Gamma toggle keys offer quick switching between full brightness and
the most recent gamma setting. Modifier keys are fully assignable, and
are available system-wide.

* Switching to gamma presets is performed via smooth fades, never
abrupt shifts in screen color or brightness.
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1.3 — System Requirements

DarkAdapted requires the following hardware setup:
* Macintosh: Mac OS X 10.3.9 or later. Intel Macintosh or Power
Macintosh.

* Windows: Windows 2000 or later. pc capable of running Windows
2000 or later.

* Windows: Compatible monitor and video card.

* At least 25 MB available hard disk space.
1.4 — Special Thanks

Special thanks to my wife, Nancy, who endures my descriptions of the latest
DarkAdapted features, and patiently sits down to look at the DarkAdapted
interface. :-) She also helps proofread the documentation and tests the prod-
uct.

1.5 — Trademark Information

All trademarks referenced herein are property of their respective owners.

1.6 — Guide Layout

Mac This symbol references features or behavior specific to Macintosh
computers. Such items are not applicable to 1BM-compatible pC’s.

Win~ When you see this symbol, the manual discusses features or behav-
ior specific to 1BM-compatible computers. Such items do not apply
to Macintosh computers.

Pro  This symbol denotes features relevant only to DarkAdapted Pro,
which operates only on the Macintosh platform.

‘Throughout this User Guide, menu selections and menu titles are depicted
using the following typeface: Menu Title

Keyboard equivalents are shown using the following key symbols:

‘3:@ command‘ ‘-\__ option‘ ‘ﬁ shift‘ ‘Acontrol‘

...along with the modifier key(s). For example, means that you
hold down the (command) key while typing the letter [s].

Win~ If you are using DarkAdapted for Windows, substitute the
key for the key.

Win If a keyboard equivalent with no menu counterpart doesn’t seem
to be working, simply add the key to implement the action.
This is necessary because Windows doesn't allow window keyboard
shortcuts that override menu keyboard shortcuts, even when the
menu is disabled.

Window names appear in boldface, as in Scheduling window.

Hyperlinks appear in blue text. Links to web pages are underlined, such as
DarkAdapted web site. Links to other pages in this document appear as fol-
lows: “Scheduled Event Execution” on page 30.

DarkAdapted has been designed with ease of use in mind. Any features of the
program not covered in this brief guide are, hopefully, self-explanatory. Your
suggestions for improvement are always welcome!

1.7 — Connecting to Our Web Site

Clicking the web address in the Control window will launch your browser
and attempt to connect to the DarkAdapted web site. This will work on/y if
you have defined a default browser using your system software.
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Section 2:
Installation and Setup

2.1 — Installation

To install DarkAdapted, you should follow the below procedure. Instructions

are provided for Macintosh and Windows.

If you do not have the correct application file for your operating system, check

the DarkAdapted web site for the correct file.

Mac Macintosh Installation Instructions
* Locate and open the Macintosh disk image that you downloaded.
* Open the disk image by double-clicking it.

If a DarkAdapted disk does not appear on your desktop or in your
Finder’s sidebar, drag the disk image over the application Disk
Utility's icon. Disk Utility resides in your Utilities folder.

* A window will open containing the DarkAdapted installer icon, as
illustrated below. Double-click the Double-click to Install icon.
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000 __| DarkAdapted X ™
X 2 items, 3.6 MB available

" DOUBLE-CLICK THE BELOW.ICON TO INSTALL

Double-click to Install
DarkAdapted

__ DarkAdapted X

* A License Agreement window will then appear. Indicate whether or not
you agree to the terms of the license agreement; if you disagree, the

DarkAdapted installer quits.

* DarkAdapted will offer to copy itself and its documentation to a folder
named “DarkAdapted Folder” in your Applications folder, as depicted
below. Click Install to proceed with installation.

Welcome to DarkAdapted!

We recommended installing DarkAdapted in your "Applications”
@ folder.
Click "Install" to copy DarkAdapted to a folder named
“DarkAdapted Folder” in your Applications folder, click "Quit" to
exit, or click "Change Location..." to install DarkAdapted into a
different folder.

( Change Location... \ ( Quit ) ( Install )

* If you prefer to install to a location other than your Applications
folder, click the Change Location... button and select the folder where
youd like to install the DarkAdapted application and its support files.
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DarkAdapted Clock then provides confirmation of your selected folder * After you click OK in the password dialog, files are copied, and a dialog
before proceeding. lets you know where DarkAdapted was installed:

* DarkAdapted then requests an administrator’s password before it
begins the installation procedure:

- . Installation Completed Successfully.

DarkAdapted has been installed in the parent folder
“Applications”, into a folder named "DarkAdapted Folder.”

DarkAdapted X requires that you type your
A A password. The folder "DarkAdapted Folder" is now open in the Finder,
| ﬁ and you are running the updated version of DarkAdapted.

&

Name: John Q. Public

Password: [eoocecsses
V @ If you are upgrading from an earlier version of DarkAdapted, the

above dialog may contain additional information as described
©) ( Cancel ) ( oK ) below.

o’

b Details

If the installer detects an existing copy of DarkAdapted, it creates
a .zip archive of it in a folder named “Moved by Installer” before
replacing the existing application.

Similarly, if other files would be replaced by the installer, these files
are also placed in the “Moved by Installer” folder before installation
begins.

The “Moved by Installer” folder, if needed, is created inside your
“DarkAdapted Folder.” No existing files are ever deleted by the
installer.

* Click the OK button to open the DarkAdapted folder and DarkAdapted
itself.

'The Finder window containing DarkAdapted remains open so that
you may see where it was installed, and also for convenience when
creating an alias to the application or adding it to the Dock.

* 'That’s it! DarkAdapted finishes opening, and may present an introduc-
tory dialog as described in “First Run” below.

DarkAdapted User Guide — Page 7



Win~ Windows Installation Instructions * That’s it! DarkAdapted finishes opening, and may present an introduc-

* Locate the downloaded installer, which appears similar to the below tory dialog as described in “First Run”below.

illustration. The Setup utility will install the DarkAdapted application

program, documentation, and extras.

2.2 — First Run

L Instal Darkadapted Mac The first time you run DarkAdapted, a dialog will appear inviting you
M Darkadapted Setup to try DarkAdapted for free, as illustrared in “Try DarkAdapted Pro for
AquilaDigital Partnership 3
Free” on page 9.
Double-click to open the Setup utility, then follow the instructions Double-click on the icon representing the DarkAdapted application. The
on screen. Control window will then appear, as depicted below:

After installation is complete, select Read Me from the Special
menu to read any late-breaking breaking information or special
instructions.

800 DarkAdapted Pro - Screen 1

Presets: | Full Brightness b“ﬂ # Show Details

If this display becomes unreadable, press
COMMAND + SHIFT + RETURN
to restore full brightness

[ Gang Sliders

R ) 100.0%
G ) 100.0%
B ) 100.0%

DarkAdapted Pro
©2002-8 Stephen E. Hutson, All Rights Reserved Worldwide www.darkadapted.com

Control Window

Note the text that appears below the Presets: pop-up menu. These are the keys
that you must hold down to return to full screen brightness, in the event that
your adjustments result in a monitor that’s too dark to read. Press these keys
once to return to full brightness, and again to return to the previous gamma
setting.

Mac The default gamma toggle keys on the Mac platform are
(although they may be changed in the Preferences
window). All of these keys must be held down simultaneously.
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Win ‘The default Windows gamma toggle keys are
(changeable via the Preferences window). All of these keys
must be held down simultaneously.

Pro  DarkAdapted Pro can present multiple Control windows, with
each window appearing on a different screen. In this mode, the
gamma toggle keys may apply to whichever main window appears
in front, or to all windows, as set in the DarkAdapted Preferences
window.

The gamma toggle keys may also be used to toggle between full brightness
and the most recently selected gamma values. Simply release and again press
the gamma toggle keys to toggle between the two states.

To configure DarkAdapted Pro at the Control window, right-click
(or [®contral-click) in a non-control area of the window, and a contex-
tual menu opens with the choices DarkAdapted Preferences...,
Show System-wide Menu... (in DarkAdapted Pro only), and
Quit DarkAdapted.

2.3 — Try DarkAdapted Pro for Free

Mac DarkAdapted Pro is only available to users running DarkAdapted
on a Macintosh; it is not available on Windows, owing to gamma
control limitations on this platform.

To try DarkAdapted Pro’s advanced features, select Try DarkAdapted Pro...
from the Special menu, as illustrated below:

21y Special |
Try DarkAdapted Pro...

Register DarkAdapted Pro...

File

Show Control Windows
Show Usage Window

DarkAdapted User Guide...
DarkAdapted Read Me File...
License Agreement...

DarkAdapted Web Site...
Send E-mail...

Check for Program Updates...

“I'ry DarkAdapted Pro...” Menu Item

DarkAdapted Pro offers several additional features over the basic program,
including:

* A system-wide Status Item Menu, from which you may select Presets, change
brightness, control RGB values, and control virtually every DarkAdapted
setting.

* Automatic launching of DarkAdapted at login, for the current user or all
users.

* System-wide hotkeys, which allow setting brightness, gamma values, presets,
and any other item in the Status Item Menu via global key combinations.

* Global, repeating hotkeys to adjust screen brightness in selectable incre-
ments.

* The ability to share DarkAdapted preferences between all users of the same
computer, if desired.

* The ability to control multiple displays independently, using a separate
Control window for each display.

* The option of creating Preset Sets, which can implement gamma fades for
multiple screens simultaneously with a single command or hotkey.

* Scheduling capabilities, including defining events that change gamma values
on particulars days of the week, at certain times, and/or at sunrise or sunset.
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Scheduled events may control all displays and/or a single display. You may
even schedule AppleScript execution.

* Scroll wheel support for the Presets pop-up menu and the gamma sliders.
In the case of the gamma sliders, the scroll wheel control moves the sliders
in unison, and offers the option to either preserve or ignore relative gamma
intensities. In contrast, selecting Gang Sliders only ofters the option to pre-
serve relative gamma intensities.

* A system-wide AppleScript menu that can execute AppleScripts via the
menu, or via user-defined, global hotkeys.

* Enhanced AppleScript support to support the additional features of
DarkAdapted Pro.

* And much more.

After you select Try DarkAdapted Pro... from the Special menu, the fol-
lowing dialog appears:

r Bl

Try DarkAdapted Pro.

Click "Try" below to try out DarkAdapted Pro's advanced
features for 10 minutes. After 10 minutes, DarkAdapted
returns to the unregistered version.

( Cancel ;,' E—JFrra

Try DarkAdapted Pro Dialog

Select Try to enable all of DarkAdapted Pro’s enhanced features for a period
of ten minutes, or click Cance/ to continue using DarkAdapted in standard
mode.

After ten minutes, DarkAdapted Pro reverts to standard mode, and presents
a dialog allowing you to register, as described in “Registering DarkAdapted

Pro” below.

If youd like to try DarkAdapted Pro for another ten minutes, simply select
Try DarkAdapted Pro... from the Special menu again, as often as you wish.

2.4 — Registering DarkAdapted Pro

Mac DarkAdapted Pro is only available to users running DarkAdapted
on a Macintosh; it is not available on Windows, owing to gamma
control limitations on this platform.

After you have launched DarkAdapted a few times, the Register DarkAdapted

Pro window appears, as illustrated below:

00N

4

DarkAdapted

Purchase DarkAdapted Pro, which offers:

» At least 2 free years of DarkAdapted Pro updates. m
» System-wide DarkAdapted menu with customizable global hotkeys.

» Global screen brightness hotkeys.

» Independent control of multiple displays.

» Dock icon hiding. A
» Scheduled gamma fades by day of week, time, and/or sunrise and sunset.

« AnnlaSerint cchadiilinn and avarcutian

You can obtain a serial number immediately by clicking "Upgrade" below.

You can show this window at any time by selecting "Register DarkAdapted Pro or Enter Serial
Number” from the "Special” menu. If you prefer to pay via PayPal, hold down the SHIFT key while you
click "Upgrade" below.

( Don't remind me Yy € Remind Later A € Try DarkAdapted Pro... ) ( Upgrade )

ey

Name:

Enter DarkAdapted Pro Serial Number:

Once you purchase a Serial Number, you can paste or type it below to enable
DarkAdapted Pro's advanced features.

Serial Number: Enter Serial Number Here | Paste Serial Number

Once you enter a valid Serial Number, you may click "Activate” to finalize

the registration. Activate

Register DarkAdapted Pro Window

You may also summon the above window at any time by selecting Register
DarkAdapted Pro or Enter Serial Number... from the Special menu.

To immediately obtain a serial number and begin using DarkAdapted Pro’s
advanced features, connect to the Internet if necessary, then click the Upgrade
button. You will be directed to our secure web site, where you may immedi-
ately obtain a serial number.

Clicking the Upgrade button takes you to our secure online store,
and provides you with a serial number immediately. If you would
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prefer to use PayPal, hold down the key while clicking
Upgrade, and you will be directed to our web page where you have
the option of paying via PayPal.

Other choices in the Register DarkAdapted Pro window include the 77y
DarkAdapted Pro... button, which performs the same function as the menu
command discussed in the section “Try DarkAdapted Pro for Free” on page 9.

'The Don’t Remind Me button dismisses the Register DarkAdapted Pro win-
dow so that it shouldn’t appear again in the present version of DarkAdapted,
and the Remind Later button postpones the window until the next time

DarkAdapted is opened.

Entering Your Serial Number

Once you have received your serial number, you can again open the Register
DarkAdapted Pro window by selecting Register DarkAdapted Pro or Enter
Serial Number... from the Special menu.

Locate the section of the window marked Enter DarkAdapted Pro Serial

Number, and enter your name and/or organization into the text entry field
labeled Name.

Next, copy the serial number from your order confirmation screen, order
confirmation e-mail, etc., then click the Paste Serial Number button to enter
it into the Serial Number text field. Alternatively, you may click to select the
Serial Number text entry field, then type your registration code.

@ You don't have to carefully select the serial number in order to use
the Paste Serial Number button — you may copy any text that con-
tains your serial number, and the Paste Serial Number button will
still work.

Once a Name and valid serial number has been entered, the Activate button
becomes operational, and you may click it to complete the upgrade process.

All of DarkAdapted Pro’s features will then be enabled.

2.5 — Selecting a Preset

DarkAdapted includes several built-in presets, selectable via the Presess: pop-
up menu, as depicted below.

Set: All Displays 80%
Set: All Displays 90% -
Set: All Displays 100% L

@ Show Details

Bright Red JURN

7670 m _J

Presets: | v Full Brightness

" Gang sli Dark Red

Full Green
—

R Bright Green 8 255
Dark Green

G =-— pr— 255
Edit Presets... b
Edit Preset Sets...

8 ™  Save Current Setting... p—G 255

DarkAdapted Pro

©2002-7 Stephen E. Hutson, All Rights Reserved Worldwide www.darkadapted.com

The Presets Pop-up Menu

When a preset is selected, the screen fades to the selected gamma setting. A
preset set is a special type of preset that can control multiple displays, and is a
DarkAdapted Pro feature described in “Preset Sets” on page 18.

The most recent preset selected may be restored when you next
launch DarkAdapted, by changing the appropriate setting in the
Preferences window, as described in “Restore previous gamma val-
ues on program launch” on page 24.

Pro You may define global hotkeys for any preset, so that the preset
can be accessed from anywhere on your computer, no matter which
application program is in front. Setting hotkeys is described in

“System-wide Menu Hotkeys” on page 27.

Any preset in the Presets: pop-up menu may also be selected via the keyboard
whenever a Control window is frontmost. In the below illustration, the text
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orange has been typed on the keyboard, and so appears above the Presets:
pop-up menu:

_orange

Presets: | Full Bnghtness —

Miscellaneous Options — Preferences Window

DarkAdapted will then automatically display the first preset in the Presefs:
pop-up menu beginning with the text you type. For example, typing ora
would select a preset named Orange, if that is the first preset in the menu
beginning with the three letters ora.

Typing a single character will toggle between

Brightness and the last selected gamma setting.

Full

If no entries in the Presets: pop-up menu begin with the text you typed,
nothing is selected from the menu, and the text you typed will clear from the
display after a one-second delay.

The key will delete the last character typed.

@ Typed entries normally select a matching preset one second after
you type the last character. To select the matching preset immedi-
ately, press the or key after typing the preset’s name.

Pro  DarkAdapted Pro users may position the cursor over the Presets:
pop-up menu and change the selected preset by using the scroll

wheel on the mouse.

'The Presets: pop-up menu automatically changes to reflect any
preset that matches the state of the gamma sliders. So, if you have
defined a preset named Gray that consists of red, green, and blue
values of 70% each, the Presets: pop-up menu will automatically
switch to Gray when you again move all three sliders to 70%.

Q

2.6 — Showing Additional Detail

When first launched, DarkAdapted displays its Control window with all of
its controls and explanatory text. To display the full (maximized) Control

window at any time, click to select the checkbox control entitled Show Details
to reveal additional controls and displays, as shown below.

0N DarkAdapted Pro - Screen 1

Presets: | Full Brightness

D--:--} E‘ Show Details
If this display becomes unreadable, press

COMMAND + SHIFT + RETURN
to restore full brightness

[ Gang Sliders

R ) 100.0%
G ) 100.0%
B ) 100.0%

DarkAdapted Pro

©2002-8 Stephen E. Hutson, All Rights Reserved Worldwide www.darkadapted.com

Expanded Control Window

The three slider controls control the primary colors red, green, and blue —
and they are labeled with the first letter of each color’s name. To the right of
each control is displayed the actual gamma value of the corresponding color,
which by default shows the current gamma percentage for each primary
color. You may change the readouts to instead display the actual gamma value
(between 0 and 255) in the Preferences window.

Click and drag any slider to change its gamma value.

'The four regions near the bottom of this window reveal the results of your
gamma adjustments. The text field at lower left displays both selected and
normal text; the remaining displays show both black text and white text on
backgrounds that correspond to the three primary colors.

These display regions are useful in determining whether your
changes may render text or graphics unreadable under certain cir-
cumstances.

Pro  DarkAdapted Pro users may position the cursor over the gamma
sliders and move the sliders in unison by using the scroll wheel on

the mouse.
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2.7 — Showing Less Detail 2.8 — Ganged Sliders

Click to deselect the Control window’s Show Details control to minimize the By default, DarkAdapted allows independent control of each gamma channel
Control window, as depicted below: (red, green, and blue). To instead move the sliders in unison, click to select the

. } Gang Sliders control in the Control window, as depicted below:
® O ) DarkAdapted - Controlling All Sc...

76 e O DarkAdapted Pro - Controlling All Screens

Full Brightness [%) [ show Details

Presets: | m @Show Details

Minimized Control Window

If this display becomes unreadable, press
COMMAND + SHIFT + RETURN

When minimized, the Control window occupies much less screen area, hid- to restore full brightness
ing the text displays, the gamma sliders, and the text which reminds you ™ Gang siiders P it R elative Ve sies
which gamma toggle keys will restore the screen to full brightness. R Avs 052.5%
@ DarkAdapted “remembers” the Control window’s position inde- —
pendently for both its expanded and minimized states. This allows G A4 076.1%
you to preserve one desired screen position for the expanded
Control window, and a different screen position for when the win- 8 & 100.0%
dow is minimized. : _

DarkAdapted Pro
©2002-7 Stephen E. Hutson, All Rights Reserved Worldwide www.darkadapted.com

Ganged Sliders Mode

Ganged slider mode preserves the relative red, green, and blue values, until
one or more sliders reaches the end of its travel, then the relative values are
discarded. For example, if you start with the following gamma values:

# Gang Sliders ["] Maintain Relative Values

R 6' 080.0%
G 6 020.0%
8 6 020.0%
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...and then slide the Red slider left toward 20%, the Green and Blue sliders

'The Gang Sliders and Maintain Relative Values settings are preserved when you

will follow along, stopping at 0%, since no slider can go below 0%, as shown quit and re-open DarkAdapted.

below:
@ Gang Sliders [ Maintain Relative Values
R .;’_‘7 020.0%
G \vj 000.0%
8 v’\:/'v 000.0%

But when you return the Red slider to 80%, note that the Green and Blue
sliders are now much closer to the Red slider’s value, as shown below:

@ Gang Sliders

[" Maintain Relative Values

R — 080.0%
G = 060.0%
B = 060.0%

In other words, the relative gamma values between the Red slider and the
Green and Blue sliders have changed, because the Green and Blue sliders “bot-

tomed out” at 0% when you moved the Red slider to the left.

If you wish to instead preserve the relative gamma values of all three sliders
in Ganged Mode, click to select Maintain Relative Values. When Maintain
Relative Values is checked, DarkAdapted “remembers” the relative gamma

values, even if one or more sliders reach the end of their travel.

The easiest way to understand the effect of Maintain Relative Values is to
experiment with the control on and off. Make sure you set the sliders at

greatly differing starting values to see the effect.

In Ganged Mode, you may still temporarily move a slider indepen-
dently of the others. Simply hold down the [ shift] or (Coption] / [ALT ]
key as you click on the desired slider, and you may move it without

affecting the other sliders.

Pro You may use your mouse’s scroll wheel to control the sliders in
Ganged Mode. Simply position the mouse over the slider region
and adjust the scroll wheel on your mouse. Note that scroll wheel
support is a DarkAdapted Pro feature which requires registration.

Page 14 — DarkAdapted User Guide




2.9 — Keyboard Control of Gamma Values

When any Control window is active, you can press the key to numerical-
ly specify gamma values, entering those values via the keyboard. The Control
window is depicted below, as it appears after pressing the key:

) 8o DarkAdapted Pro - Screen 1

Presets: | Full Brightness f :] @Show Details
If this display becomes unreadable, press
COMMAND + SHIFT + RETURN
to restore full brightness

| Gang Sliders
R -3 255
y— 8
G \vd 255
=
B \vi 255
text text Text

DarkAdapted Pro

©2002-7 Stephen E. Hutson, All Rights Reserved Worldwide www.darkadapted.com

Keyboard Control of Gamma Values

In the above illustration, note that the gamma value display to the right of the
Red slider appears as editable text, and is selected. You may select the Green
and Blue values by again pressing the key.

Holding down the key as you press selects the gamma value

displays in reverse order.

Once you have selected a gamma value for editing as described above, you
may type in any valid gamma value between 0 and 255, or between 0% and
100%, as described below:

* If you type in a number without a percent sign (“%”), DarkAdapted
expects a gamma value between 0 and 255. All displays will change to
reflect gamma values, if they were showing percentages.

* If you type in a number wizh a percent sign (“%”), DarkAdapted expects
a gamma percentage between 0 and 100. If necessary, all displays will
change to show gamma values as percentages.

@ When you want to toggle between percentage and numeric displays,
simply press the key when editing any of the gamma value dis-
plays. The display will alternate between the corresponding slider’s raw
gamma value (zero to 255) and its percentage value.

When the gamma displays are displaying gamma percentages, and you press
the key, only the numeric portion of the gamma percentage is selected,
to speed keyboard entry, as shown below:

R 6 100.0%
)

G 7} 100.0%

B % 100.0%

You may simply type the number portion of the percentage, and it will replace
the selected text, leaving the percent sign (“%”) intact. If you instead wish to
enter a raw gamma value between zero and 255, simply press the key
to toggle between percentage and raw value modes.

Once you have typed a gamma value, you can implement the change in one
of the following ways:

* press the key to select the next display, or

* press [ RETURN | , [ ENTER | , Or [ ESCAPE | , or

* move the mouse, or
* activate any other window.

Editing the gamma value displays to change between percentage and raw
display values also changes the state of Report Gamma Values as Percentages
in the Preferences Window, as described in “Editing Preferences” on page 20.

@ You may also move the sliders via the arrow keys. First, select the text
to the right of the slider you wish to change. You may select the text by
clicking in the text display, or by pressing the key.

To move the selected slider to the right, hold down one of the modifier
keys [88 command] , \Coption] , or [N control] — and press the [3] or [*] key. To move
it to the left, hold down one of the modifier keys (3§ command], [\ option] , or
— and press the [€] or [¥] key.

It Gang Sliders is activated, you may move on/y the selected slider by
using the key modifier while pressing the arrow key. Otherwise,
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move all sliders in unison by holding down [§8 command] or [\ option] while
pressing the arrow key.

2.10 — Saving a Preset

Once you have defined a useful screen gamma value, you will probably want
to use it again. DarkAdapted provides a simple method by which you may add

as many presets as you desire.

Add a preset by selecting Save Current Setting... from the Presets: pop-up
menu (or by selecting Save Current Screen as Preset... from the File menu,
or by typing ). A window will then appear, where you may define

a new preset or replace an existing one, as shown below:

44

@ New Preset:

Save Current Gamma Setting as Preset.
You may save the current gamma setting as a new preset with the

name of your choice, or replace an existing preset with the current
gamma values.

New Preset 1

Full Blue ’

-

" Replace Preset:

@ Selecting Preset Changes Options: @ Cang Sliders

¥ Maintain Relative Values
smded

Creating a Preset

If you would like to create a new preset, click the New Preset: button, then
enter the desired name for the preset into the text field to the right of the
button.

To replace an existing preset, click the Replace Preset: button, then select the
existing preset that you would like to replace from the pop-up menu.

If, when you select this preset in the future, you would like to change the
Control window options Gang Sliders and Maintain Relative Values, click to
select the checkbox labeled Selecting Preset Changes Options: Once selected,
you may then toggle the state of the Gang Sliders control, and — when Gang
Sliders is selected — also toggle the state of Maintain Relative Values.

Click OK to add the preset to the Preses: pop-up menu, and to make it avail-
able throughout the program. If you wish to continue without adding the new
preset, simply click Cancel to return to the Control window.

2.11 — Managing Presets

DarkAdapted gives you control over how your presets appear in the pop-up
menu and throughout the program, and the program lets you delete, dupli-
cate, and rename presets that you have added to the program.

Presets may also be stored in disk files. If you have downloaded a presets file
— or wish to load one of the sample files included with DarkAdapted — you
may double-click the presets file or drag it over the DarkAdapted application
icon to load its contents. You may also load a presets file from the Edit Presets
window, as described below.

Win~ Since DarkAdapted does not attempt to modify your Windows
registry, double-clicking a presets file may not load the file.
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You may edit your presets by selecting Edit Presets... from the Presets:
pop-up menu, by selecting Edit Presets... from the Edit menu, or by typing
.'The Edit Presets window appears, as shown below:

4

User Presets (drag to reorder):
Full Blue

Edit User Presets

User Presets are helpful when you have a favorite gamma setting, and you wish to easily return
to that setting.

Select presets from any Control Window's "Presets” pop-up menu. In DarkAdapted Pro, select
presets from the system-wide menu, and assign global hotkeys to any preset.

Selected Preset:

Bright Blue Preset Name: New Preset
Red Color Values: R: 2553 c:142/% 80 03 [
Orange
Yellow @ Preset Changes Options: || Gang Sliders
Creen —
Blue __ Maintain Relative Values
Violet
------------ Actions:
New Preset 5
Perform Action: Actions... &
: Include Slider Options when Saving File
: o ‘ ! Include Slider Options when Importing File
Separator : Duplicate... | \ Delete...

1 Discard ;) 6 'Savewa

Edit Presets Window

Every preset that you have defined or imported from a file will appear in the
scrolling list. Select all presets by choosing Select All from the Edit menu, or
by typing .

To change the name of any preset, select the preset by clicking on its name
in the scrolling list, then edit the Prese Name: in the Selected Preset: area of
this window.

The selected preset’s Color Values are also displayed here, with numbers
between zero and 255 representing the values for each color component (red,
green, and blue). The displays for red, green, and blue are labeled R:, G:, and
B: respectively.

You may change the red, green, and blue components of the selected preset by
using the arrow controls to the right of each value.

The selected preset’s gamma color is also displayed visually in a colored square
which appears to the right of the Color Values: control area.

You may also use your operating system’s Color Picker dialog to change the
gamma hue; simply click on the colored square that appears to the right of
the Color Values: controls.

It is also possible to specify that a preset can change certain Control window
options when the preset is selected. To specify that this preset should change
the Control window options Gang Sliders and Maintain Relative Values, click
to select Preset Changes Options: Once selected, you may then toggle the state
of the Gang Sliders control, and — when Gang Sliders is selected — also toggle
the state of Maintain Relative Values.

Duplicate an entry by selecting it and clicking Duplicate to save a copy of a
preset under a different name.

Delete any number of presets by selecting one or more list entries, then
click the Delete button (or press the [DeeTe | or [Backseace ] key). The selected
preset(s) will be deleted after a confirming dialog.

You may skip the confirm deletion dialog by holding down the
or key while deleting the entry as described above.

You may also change the order by which your presets appear in the Control
window’s Presets: pop-up menu. Simply click and hold on an entry, then drag
it to the desired location in the listing.

You may also organize your presets by adding separators to your listing.
Clicking the Separator button inserts a separator after the currently selected
preset. If no preset is selected, a separator is added to the end of the listing.

DarkAdapted does not allow the following actions: adding a separator when
another separator is selected, exporting only separators to a file, renaming a
separator, or duplicating a separator.
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'The Actions: area of the Edit Presets window offers several useful features, as
described below:

'The pop-up menu labeled Perform Action... offers additional options when
you click on the pop-up menu and hold down the mouse button, as depicted
below:

Actions:

Perform Action: ¥ Actions...

' Include Slider O

Save Selected Presets to File...

Save All Presets to File...
_lInclude Slider O

= Load Presets from File (append to list)...

Load Presets from File (replace list)...

Delete Selection...
Delete All...
T —

The Perform Action Pop-up Menu

Select one of the options from this pop-up menu, as described below:

* When at least one preset is selected, you may choose Save Selected Presets
to File... to summon a save dialog, where you may specify a name and disk
location for the presets file. Only the selected preset(s) (and separators, if
any) will be saved to the disk file.

* When one or more presets have been defined, you may choose Save Al
Presets to File... to summon a save dialog, where you may specify a name and

disk location for the presets file. All presets and separators in the scrolling
list will be saved to the disk file.

* When no presets have been defined, you may select Load Presets from File. ..
to summon an open dialog, where you may select a presets file from any
available disk. Any presets and separators in the disk file will populate the
scrolling presets listing.

* When one or more presets have been defined, you may choose Load Presets
from File (append to list)... to summon an open dialog, where you may select
a presets file from any available disk. Any presets and separators in the disk
file will be added to the end of the scrolling presets listing, and will become
selected.

* When one or more presets have been defined, you may choose Load Presets
Jfrom File (replace list)... to summon a file selection dialog, where you may

select a presets file from any available disk. Any existing presets will be
removed from the scrolling listing, and all presets and separators in the disk
file will populate the scrolling presets listing, and will become selected. You

may suppress the warning dialog by holding down the or key.

* When at least one preset is selected, you may choose Delete Selection... to
remove the selected presets and/or separators from the listing. A confirming
dialog will appear, but you may suppress it by holding down the or
key.

* When at least one preset has been defined, you may choose Delete All... to
remove all presets and/or separators from the listing. A confirming dialog

will appear, but it may be avoided by holding down the or key.

Q@ When loading or saving presets files, the file selection dialog opens
at the default presets file directory (folder). This folder is defined
as being located in the same directory as DarkAdapted, containing
“Presets” in the folder’s name. If no folder meets this requirement,
DarkAdapted selects the first folder it may find containing presets
files. You may override this behavior by holding down the
key while opening or saving presets files.

Presets may optionally change the Control window options Gang
Stiders and Maintain Relative Values, as described earlier. By default,
DarkAdapted does not include this information in files that it saves
and loads.

To save Gang Sliders and Maintain Relative Values information into
your presets files, click to select Include Slider Options when Saving
File — and then save the file as specified above.

To include any Gang Sliders and Maintain Relative Values informa-
tion that may be present in a presets file that you are loading, click
to select Include Slider Options when Importing File— and then load
the file as specified above.

When you are satisfied with the changes you have made in the Edit Presets
window, click the OK button to implement your changes, or click Cance/ to
discard all changes you made since the window opened.

2.12 — Preset Sets (Pro Only)

Pro  Preset Sets are only available if you have upgraded to DarkAdapted

Pro, or when you select Try DarkAdapted Pro... from the Special
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menu. To upgrade, select Register DarkAdapted Pro... from the
Special menu.

@ You may set global hotkeys for any Preset Set, so that the Preset
Set can be accessed from anywhere on your computer, no matter
which application program is in front. Setting hotkeys is described
in “System-wide Menu Hotkeys” on page 27.

In multiple-display environments, it is often useful to change all displays in
unison. Preset Sets allow you to control up to six connected displays simulta-
neously.

For example, you may define a Preset Set that changes your primary monitor

to bright red, and your secondary display to dark red.

Define Preset Sets in the Edit Preset Sets window, which you may access as
follows:

* Select Edit Preset Sets... from any Control window’s Presets:
menu, or

* Select Edit Preset Sets... from the Edit menu, or

* Select Edit Preset Sets... from the System-wide Menu, or

* Type

'The Edit Preset Sets window is depicted below:

4

Edit Preset Sets

Preset Sets are useful when you have more than one display, and you want to set each display
to a different gamma setting with a single command. A single Preset Set may control up to six
displays.

Select Preset Sets from any Control Window's "Presets" pop-up menu, or from the System-wide
Menu. You may assign hotkeys to any Preset Set.

Preset Sets (drag to reorder): Selected Preset Set:

Preset Set A

Preset Set B Preset Set C

Preset Set Name:

O Activate at Launch 8 No Set Activates at Launch

Display: Apply Preset:

Display 1: | Yellow [y ]
Display 2: | Yellow -+
Display 3: | No Change 4+
Display 4: | No Change ?]
Display 5: | No Change 3|
Display 6: | No Change B

New Set ‘ |Separator‘ ‘ Delete... ‘ (" Discard \( Save )

Edit Preset Sets Window

Existing Preset Sets appear in the scrolling listing labeled Presez Sets (drag to
reorder). Select a Preset Set by clicking on it. Select all Preset Sets by choosing
Select All from the Edit menu, or by typing . You may control the
order in which Preset Sets appear by dragging the desired Preset Set to a new
location in the scrolling list.

Create a new Preset Set by clicking the New Sez button. The new Preset Set
will appear in the Preset Sets listing, and you may change its name and options
in the Selected Preset Set: section of this window.

You may specify an option for each of up to six connected displays, using the
pop-up menu that appears next to the desired display. Display 1 is your pri-
mary display (the one containing the menu bar), and you may define actions
for up to five other displays, even if they are not presently connected.
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For each display, you may select an existing gamma preset from each pop-up
menu. You may also select No Change, which means that the desired display
will be unaffected when the Preset Set is selected.

Preset Sets that you define will appear in most of the same places as regular
gamma presets, namely:

* In any Control window’s Presezs: menu, and
* In the System-wide Menu

Preset Sets do 7oz appear in the Scheduling window, however. There, you may
apply a given preset to all monitors, or simply create separate events for each
desired display.

You may drag Preset Sets to different positions, to change their display order.
As with gamma presets, you may add a separator after the selected Preset Set

by clicking the Separator button.

Additionally, you may specify that one Preset Set is activated when you first
open DarkAdapted Pro. Simply click once on the Preset Set’s name in the
Preset Sets listing to select the set, then click the button captioned Activate at
Launch.

To change the Preset Set that activates at launch, simply select a different
Preset Set, then click Activate at Launch for the selected set. To specify that 7o
Preset Set activate at launch, click the No Set Activates at Launch button when
any Preset Set is selected in the Preset Sets listing.

Specifying a Preset Set that activates at startup will override the
application preference Restore previous gamma wvalues on program

launch, described in “Editing Preferences” on page 20.

Delete one or more selected Preset Sets by selecting the desired Preset Set(s),
then click the Delete... button (or press the key). Skip the warning
dialog by holding down the key as you click the Delete... button or
press the key.

To save any changes you have made in the Edit Preset Sets window, and to
close the window, click the Save button. Click Discard to close the window
without saving changes.

2.13 — Editing Preferences

To summon the Preferences window, select the Preferences... menu item as

described below, or type [.] (comma).

Mac Select Preferences... from the DarkAdapted X menu.
Win Select Preferences... from the Edit menu.

'The Preferences window will then appear, as depicted below:

DarkAdapted Preferences

Gamma Toggle Keys: DarkAdapted Pro Options:
Toggle between full brightness and the last gamma

¢ ) Minimum Allowable Brightness: 100 |
setting when these keys are pressed 3

M - H
COMMAND + SHIFT + RETURN = OpenatLogh Lo

= ¥ Show Dock icon
Define Gamma Toggle Keys... =
i i i i I Show Control Window(s) when DarkAdapted Activates
| Show ﬂ

Gamma Fades: System-wide menu

Steps: | 15 ? Higher numbers = slower fades
Miscellaneous Options:
" Sliders track gamma values during gamma fades
M Closing Control Window quits DarkAdapted
M Report gamma values as percentages S
] Restore previous gamma values on program launch
seconds

Internet Update Checking ‘j’ Refresh gamma values every 5

"1 Reset suppressed warning dialogs

Check for updates: | Via "Special® Menu Only ﬂ

¥ Show Help Tags

'i' Check for pre-release versions if available

Check for Updates Now...
ary ) ( )
Discard Save

DarkAdapted Preferences Window

'The Preferences window is where you can customize DarkAdapted to suit
your tastes and requirements. There are several groups of controls in this win-
dow, and each group is pictured and described below.
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Gamma Toggle Keys Mac Type any combination of modifier keys, plus the desired non-
modifier key, to set the gamma toggle keys. Modifier keys are

Gamma Toggle Keys: [38 command] , [{3 shift] , \Coption] , and . Non-modifier keys are most
Toggle between full brightness and the last gamma of the other keys on your keyboard. At least one modifier key must

tting when these k o . . . )
S PIS PSS be selected, unless the key is a function key, in which case you may

press only the function key, or the function key plus any modifier
‘ Define Gamma Toggle Keys... 1 key(s).

COMMAND + SHIFT + RETURN

@ Almost any Macintosh non-modifier key may be selected, includ-
Gamma Toggle Keys — Preferences Window ing function keys and many other keys on the extended keyboard.
Note that the numeric keys that appear above the letters on your
keyboard are nof the same as the numeric keys on your numeric

keypad. This gives you greater flexibility in defining hotkeys.

'The Gamma Toggle Keys: section, depicted above, allows you to select which

keys — when held down simultaneously — will return your monitor(s) to full

brightness. Pressing the keys again will restore the previous gamma setting.

Click the Define Gamma Toggle Keys... button to change the gamma toggle Win~ Select any modifier key(s) by clicking to select the correspond-

keys, and one of the following windows appears, depending on your com- ing checkbox control, and type a non-modifier key to change the

puter’s operating system: displayed key name. Modifier keys are [“control| , [{}shift|, [AT ], and
[winoows |. Non-modifier keys are most of the other keys on your
keyboard. At least one modifier key must be selected.

To set the hotkey, press the desired modifier key(s) (COMMAND, OPTION,

SHIET, M0 ok CONTOL) and the desirec:Bofkey: how. Pro DarkAdapted Pro may control multiple displays independently. If

Current Gamma Toggle Keys: you have registered DarkAdapted Pro for Macintosh, and wish to

oS ShIR i rativn have the gamma toggle keys control all displays in unison, click to
select Apply to all displays. Leaving Apply to all displays applies the
Gamma Toggle Keys to only the frontmost Control window.

@ Apply to all displays u," Cancel ‘) ( OK )

Click OK to save the changes you made to the gamma toggle keys, or click

Cancel to close the window without changing the key combination.
Set Gamma Toggle Keys Window — Macintosh

Gamma Fades

Set Gamma Toggle Keys
GCamma Fades:
To set the hotkey, select the desired modifer keys below and press the desired key. Steps: 15 %) Higher numbers = slower fades
‘:‘ Sliders track gamma values during gamma fades
[Iwindows Control [ Al Shift peturn|
@ Report gamma values as percentages
Gamma Toggle Key:

Control + Shift + return

Gamma Fades — Preferences Window

[Japply to all displays [ Cancel ] L OK ]

The section entitled Gamma Fades: contains three controls:

Set Gamma Toggle Keys Window — Windows * The Steps: pop-up menu lets you control the speed of gamma transi-
tions. Selecting “1” will result in a nearly instantaneous gamma tran-
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sition. The default value of “60” results in a gamma fade which lasts
approximately one second.

* Selecting the control labeled Sliders track gamma values during gamma
fades causes the slider controls in the Control window to move as their
corresponding gamma values change.

* Report gamma values as percentages controls how the current gamma
values are displayed to the right of the Control window’s gamma con-
trol sliders. When selected, the readouts are populated with percentage
values between zero and 100%. When this control is deselected, the
slider readouts report the gamma value as integers between zero and
255.'This controls the display format only; functionality is not affected
by this control’s setting.

Internet Update Checking

Internet Update Checking:

Check for updates:  Via "Special” Menu Only 5 ]

| Check for pre-release versions if available

l Check for Updates Now... ‘

Internet Update Checking — Preferences Window

'The Internet Update Checking: section controls DarkAdapted’s version check-

ing functionality, as described below:

*'The Check for updates: pop-up menu controls whether DarkAdapted
checks for updates manually, or automatically at a selectable inter-
val. Select Via “Special” Menu Only to check for newer versions of
DarkAdapted only when you select Check for Program Updates...
from the Special menu. If you select Every Week, DarkAdapted will
check for a newer version every seven days. Selecting Every Month

causes DarkAdapted to check for updates every thirty days.

* To also check for newer alpha or beta versions of DarkAdapted, click
to select Check for pre-release versions if available. Pre-release versions of
DarkAdapted always check for such releases, regardless of this controls
setting.

Click the Check for Updates Now... button to immediately check for

program updates, which requires you to close the Preferences window.

@ An Internet connection must be established in order for update
checking to occur. If you use a dialup or other Internet connection
that is not always available, we recommend selecting Via “Special”

Menu Only from the Check for updates: pop-up menu.

More information regarding Internet update checking will be found in

the section “Internet Update Checking” on page 35.
DarkAdapted Pro Options (Pro Only)

DarkAdapted Pro Options:

[") Minimum Allowable Brightness: 100
"1 Open at Login Hidden

B‘ Show Dock icon

[ Show Control Window(s) when DarkAdapted Activates

System-wide menu: | Show 3

DarkAdapted Pro Options — Preferences Window

When you have registered DarkAdapted Pro for Macintosh, the DarkAdapted
Pro Options control group is enabled.

Pro  DarkAdapted Pro Options are described below, and are only available
once you register DarkAdapted Pro. To upgrade, select Register
DarkAdapted Pro... from the Special menu.

* If you want to avoid situations where your monitor becomes too faint to
read, click to select Minimum Allowable Brightness. When this feature is
selected, the brightness readout may be set to any value between 1 and 400,
using the up and down arrow controls to the right of the readout.

When activated, Minimum Allowable Brightness causes the Control win-
dow’s gamma sliders to enforce the total brightness limit that you set here.
Each of the Control window’s gamma sliders (red, green, and blue), may be
set to a value between 0 and 255. When you adjust one slider downward, this
feature automatically adjusts the other two sliders (if necessary) in order to
maintain the minimum brightness you have set.

'The Minimum Allowable Brightness that you set is checked using the sum of
all three gamma sliders.

If DarkAdapted Pro enforces your minimum brightness, the Control win-
dow’s R, G, and B labels become enclosed in parentheses — (R), (G), and
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(B) — as a reminder that the displayed value reflects the minimum allowable If you opt to enable hotkeys only — and you have defined no
brightness. hotkeys for setting menu hotkeys and quitting DarkAdapted Pro,
then DarkAdapted Pro will add those hotkeys for you and display

* If you would like DarkAdapted Pro to start every time you log in to your ] )
them in a dialog.

computer, select Open at Login. By default, DarkAdapted Pro configures
your system so that DarkAdapted Pro opens at login, and remains visible. *The control labeled Show Control Window(s) when DarkAdapted Activates
To instead hide DarkAdapted Pro when it opens at login, check both Open causes any hidden Control windows to be shown when you return to

at Login and Hidden. DarkAdapted Pro from another application. To close Control windows
A bug in Mac OS X 10.4x (“Tiger”) prohibits the Hidden con- without quitting DarkAdapted Pro, make sure you do 7ot select the prefer-
trol from functioning. When using Tiger, you may open System ence Closing Control Window Quits DarkAdapted.
Preferences = Accounts & Login Items to toggle the login vis- * The System-wide menu: pop-up menu allows you to control the visibility
ibility of DarkAdapted Pro. and behavior of DarkAdapted Pro’s system-wide menu (88). Select Show to

reveal the system-wide menu at the right side of your menu. Select Hide to
prevent the system-wide menu from appearing. Selecting Hide, but enable
hotkeys causes the system-wide menu to not appear, but its hotkeys (key-
board shortcuts) continue to function.

* Show Dock icon controls whether DarkAdapted Pro appears in the Mac OS
X Dock. If you deselect this option, DarkAdapted will open without a Dock

icon the next time it is launched.

The Show Dock icon control is only available when you are
logged in as a user with administrative privileges. This is because
DarkAdapted Pro must modify its own application file in order to
change the Dock icon’s visibility. Only an administrative user may
modify the Applications folder, so if you wish to toggle the state ™ Closing Control Window quits DarkAdapted

of Show Dock icon, log in first as an administrator, then change the fz‘ Restore previous gamma values on program launch
Dock icon’s visibility. This setting will be preserved when you log
back in as a non-administrative user.

Miscellaneous Options

Miscellaneous Options:

(a)
v

M Refresh gamma values every 5 seconds

':' Reset suppressed warning dialegs

@ If you deselect Show Dock icon and set System-wide menu to W Show Help Tags
Hide, then your only interface to DarkAdapted Pro will be via
its Control window(s). To configure DarkAdapted Pro at the
Control window, right-click (or [econtro] -click) in a non-control
area of the window, and a contextual menu opens with the choices The Miscellaneous Options: controls are described below:
DarkAdapted Preferences..., Show System-wide Menu..., and
Quit DarkAdapted. You may use one of these to restore your user

Miscellaneous Options — Preferences Window

* Click to select Closing Control Window quits DarkAdapted if you want
DarkAdapted to quit whenever any Control window is closed (the

interface. default behavior). Deselect this control to simply hide the Control
If you also set the preference to deselect Closing Control Window window using its close control. If you hide the window in this manner,
quits DarkAdapted, then there will truly be no interface by which you may again show it by selecting Show Control Window from the
to control DarkAdapted Pro. If this occurs, DarkAdapted Pro will Special menu.

present a dialog which offers to show the System-wide menu, or
at least enable its hotkeys, so you have some means by which to

control DarkAdapted Pro.

Win Because closing the Control window will leave you with no menu
bar on the Windows platform, Closing Control Window quits
DarkAdapted is disabled on Windows.
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Pro  DarkAdapted Pro users who deselect Closing Control Window quits
DarkAdapted may quickly re-show all Control windows by holding
down the key while clicking DarkAdapted Pro’s Dock icon
in Mac OS X. To upgrade, select Register DarkAdapted Pro...
from the Special menu.

* When the control labeled Restore previous gamma wvalues on program
launch appears with a check mark, then DarkAdapted will store the
state of all gamma sliders (and the Presets: pop-up menu, if applicable)
when you quit DarkAdapted. The next time you launch DarkAdapted,

the screen gamma will be returned to the saved values.

Pro When you reopen DarkAdapted — and its previous state was set
to control displays independently, all displays will be returned to
their previous gamma values when Restore previous gamma values
on program launch is selected.

Pro  If you have specified that a Preset Set should be activated at launch,
then the Preset Set overrides this setting, and the Preset Set will
be activated at launch, instead of the previous gamma values.
Specifying a Preset Set to activate at launch is described in the sec-
tion “Preset Sets” on page 18.

*'The Refresh gamma wvalues every N seconds checkbox, when selected,
causes DarkAdapted to re-implement your screen’s gamma settings
periodically. This may be used, for example, to retain your preferred
gamma setting when entering and/or exiting a screen saver, which will
usually interfere with DarkAdapted’s settings. Use the small arrows
to select a refresh frequency between 1 and 60 seconds. By default,
DarkAdapted enables this setting, with a period of 5 seconds.

* The control labeled Reset suppressed warning dialogs may be used to reset
any warning dialog boxes that you have chosen not to display in the
tuture, usually by selecting a Don'’t show again checkbox or clicking a
Suppress button in a dialog. If you click to select Resez suppressed warn-
ing dialogs, all suppressed warnings will again show after you save the
preferences by clicking the Save button.

* By default, help tags (sometimes called “tool tips”) appear when you
position the cursor over many of DarkAdapted’s controls for a few

seconds. If you prefer not to see these help tags, click to deselect Show
Help Tags.

To implement any changes made in the Preferences window, click the Save
button, or click Discard to close this window without saving your changes.

2.14 — The System-wide Menu (Pro Only)

Pro 'The system-wide menu is only available if you have upgraded to
DarkAdapted Pro, or when you select Try DarkAdapted Pro...
from the Special menu. To upgrade, select Register DarkAdapted
Pro... from the Special menu.

When you first register DarkAdapted Pro (or when you select Try
DarkAdapted Pro... from the Special menu), the system-wide menu (&)
automatically appears near the right side of your menu bar. You may choose
to hide it by modifying the appropriate control in the Preferences window as

described on page 23.

The menu is illustrated below:

Preset Sets >

Presets >

v Show Control Windows #1

Show Brightness Slider #®

Show RGB Sliders 38F9

Control All Displays X {+30 Display Control >
v Control Display 1 X081l .

Control Display 2 (a2 Special : >

e —— Scheduling... " F6

AppleScripts >

Edit Menu Hotkeys... #BO

Edit Brightness Hotkeys... ¥

DarkAdapted Preferences... &\
Quit DarkAdapted B8O

DarkAdapted Pro’s System-wide Menu

@ You may set global hotkeys for any item in DarkAdapted’s system-
wide menu, so that any menu command can be accessed from
anywhere on your computer, no matter which application program
is in front. Setting menu hotkeys is described later in this section.
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'The various menu selections of the system-wide menu are discussed below.
Preset Sets

If you have defined any Preset Sets (as described in “Preset Sets” on page 18),
the first menu entry is labeled Preset Sets. When selected, a submenu opens
where you may select any Preset Set that you have defined. The submenu also
includes the command Edit Preset Sets..., which opens the Edit Preset Sets
window.

Presets

'The next menu entry is labeled Presets. When selected, a submenu opens
where you may select any of DarkAdapted Pro’s built-in gamma presets, or any
preset that you have added. The submenu also includes the commands Save
Current Screen as Preset... and Edit Presets..., which bring up the Save
Preset window and the Edit Preset window, respectively. “Saving a Preset” and
“Managing Presets” are described on page 16 and page 16, respectively.

Control Windows

'The next menu item, Show Control Windows, appears with a check mark
when at least one Control window is open. Select this menu item to alter-
nately show or hide the Control windows.

The Brightness Window

Selecting Show Brightness Slider causes the Brightness window to appear:

DarkAd;pteq - Brightnesg . Dis_play 2

Display: 2 & ’

= 076.1%
N

DarkAdapted Pro’s Brightness Window

You may select to control all displays, or a single display, from the Display:
pop-up menu. Pressing the [0] key cycles between all connected displays,
while pressing the [] key selects all displays. After you select from the pop-up

menu, the cursor moves to the brightness slider’s handle.

Moving the slider to the left dims the display, and moving it to the right
brightens the display. This control retains the relative values of red, green, and

blue on the selected display.

The slider may also be moved using your mouse’s scroll wheel. Scroll up to
increase brightness, or scroll down to decrease brightness.

You may also move the brightness slider via the keyboard. To move the slider
to the right, hold down one of the modifier keys [§8 command] , [\ option] , or [ control]
— and press the [2] or [t] key. To move the slider to the left, hold down one of
the modifier keys [38 command] , [\Coption] , or [~ control] — and press the [€] or key,

Q) 'The window opens so that the slider’s handle appears under the mouse,
unless doing so would cause the window to move partially off the screen,
in which case the cursor is repositioned to appear over the slider’s han-
dle. Thus, you will never need to reposition your cursor in order to start

changing the brightness.

Unlike the Control window and the RGB Sliders window, the
Brightness window displays the brightness percentage only; there is
no way to toggle the display to show a “raw” brightness value. This is
because there is no “raw” brightness value; the number of steps between
zero and full brightness varies, depending on the screen gamma value
when you first open the Brightness window.

You may also type a numeric brightness value using the keyboard. Enter a
valid number between zero and 100%, and the screen brightness will update
when you press the [18] , [Return] , or [EnTER] key. Pressing the key

updates the screen brightness and closes the Brightness window.

Some systems may prevent text entry in the Brightness window, because
some software additions and system revisions do not allow floating win-
dows to receive the focus for entering text.

The control disappears when the mouse leaves the Brightness window. To
help you avoid accidentally closing the window, DarkAdapted waits until the
mouse is at least 30 pixels outside of the window’s border before the window
closes.
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The RGB Sliders Window
When you select Show RGB Sliders from the menu, the RGB Sliders win-

dow appears:

DarkAdapted - RGB Sliders - Display 1
Display: 1 e ! @ Gang @ Maintain Relative Values
Yo ¢

020.4%

R ¥
/

G &9 100.0%

\/

B 9 100.0%

\

DarkAdapted Pros RGB Sliders Window

You may select to control all displays, or a single display, from the Display:
pop-up menu. Pressing the [0] key cycles between all connected displays,
while pressing the [A] key selects all displays. After you select from the pop-up

menu, the cursor moves to the Red slider’s handle.

'The controls in this window function identically to those in the Control
window, which was discussed previously. The R, G, and B sliders control the
selected display’s red, green, and blue gamma values respectively. The Gang
control functions identically to the Control window’s Gang Sliders control
(described in “Ganged Sliders” on page 13).The Maintain Relative Values func-
tions identically to the control named Maintain Relative Values in the Control
window (see “Maintain Relative Values” on page 14).

'The sliders may be moved in unison using your mouse’s scroll wheel.

You may also move the sliders via the keyboard. First, select the text to the
right of the slider you wish to change. You may select the text by clicking in
the text display, or by pressing the key. To move the selected slider to the
right, hold down one of the modifier keys (88 command| , \Coption] , o1 [~ control] — and
press the [] or [*] key. To move it to the left, hold down one of the modifier
keys [$8 command] , [\Coption] , or [~ control] — and press the [€] or [¥] key.

@ The window always opens so that the red (top) slider’s handle appears
under the mouse, unless doing so would cause the window to move par-
tially off the screen, in which case the cursor is repositioned to appear
over the slider’s handle. Thus, you will never need to reposition your cur-
sor in order to start changing the sliders in ganged mode.

You may toggle the state of Gang by pressing the [¢] key on your keyboard.
If Gang is active, you may also toggle the state of Maintain Relative Values by
pressing the [v] key.

You may also use your keyboard to type numeric gamma values, entering these
values as raw values or as percentages.

As with the Control Window (described on page 15), you may press the
key to alternately select red, green, and blue values sequentially (or select in

reverse order by typing ).

Some systems may prevent text entry in the RGB Sliders window,
because some software additions and system revisions do not allow
floating windows to receive the focus for entering text.

Once a gamma value is selected, you may numerically specify gamma values
using the keyboard. As with the Control Window (described on page 15), you
may type a number without a percent sign to specify a gamma value between
0 and 255, and you may type in a number wizh a percent sign to enter a per-
centage. You may also press the key to toggle between percentage and

raw gamma modes.

When you change between raw gamma value and percentage display, all
displays will change to show gamma values in the same format, and the state
of Report Gamma Values as Percentages in the Preferences Window will also
change, if necessary (see “Editing Preferences” on page 20).

The screen’s gamma will update when you press the [18 ], [RETURN | , or [ENTER |
key. Pressing the key updates the gamma and closes the RGB Sliders

window.

'The window disappears when the mouse leaves the RGB Sliders window. To
help you avoid accidentally closing the window, DarkAdapted waits until the
mouse is at least 30 pixels outside of the window’s border before the window
closes.

Display Control

If you have more than one display attached to your computer, the Display
Control menu appears in the system-wide menu. In its submenu, you may
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select Control All Displays, or select the desired display number, as illustrated
below:

Control All Displays Display Control >
v Control Display 1 ~©'1 :

Control Display 2 ~02 Special >
—————— Scheduling...

DarkAdapted Pro’s Display Control Menu

'The Display Control submenu is where you define which display will be
affected by the menu commands Show Brightness Slider, Show RGB
Sliders..., the brightness hotkeys (described in “Setting Brightness Hotkeys”
on page 29), and any selection from the Presets submenu.

The Special Menu and its Submenu

'The Special menu in the system-wide menu contains several selections, as
illustrated below:

About DarkAdapted Pro...
- Scheduling...
DarkAdapted User Guide...
DarkAdapted Read Me File... AppleScripts >

License Agreement...

Edit Menu Hotkeys... #®

DarkAdapted Web Site... Edit Brightness Hotkeys...

Send E-mail...
DarkAdapted Preferences...

Check for Program Updates... s
ey QUit DarkAdapted

T —
DarkAdapted Pro’s Special Menu

'The following items appear in the Special submenu:

* The menu item About DarkAdapted Pro... brings up the About window,
which provides version and copyright information.

*The three documentation-related menu items — DarkAdapted User
Guide..., DarkAdapted Read Me File..., and License Agreement... —
attempt to open these documentation .pdf files, if they can be located.
DarkAdapted Pro expects to find these documents in the same folder as
DarkAdapted Pro, or in a subfolder named “Documentation.” If located,

DarkAdapted Pro attempts to open one of these documents using your
default reader for .pdf files.

* Selecting DarkAdapted Web Site... opens your default web browser, and
attempts to connect to our web site: www.darkadapted.com. You must be
connected to the Internet, and your system must support automatically
opening your web browser — in order for this command to function.

* Select the menu item Send E-mail... to open your default e-mail client,
pre-addressed with our support e-mail address, and a subject line indicating
your DarkAdapted version. In order for this to work, your system must sup-
port automatically opening your e-mail program.

Scheduling

'The Scheduling... menu item brings up DarkAdapted Pro’s Scheduling win-
dow, as described in “Scheduled Event Execution” on page 30.

AppleScripts

DarkAdapted can execute AppleScripts via the system-wide menu or via
global hotkeys. The menu item AppleScripts... provides access to these
scripts, and it is described in “Running AppleScripts” on page 30.

Edit Menu Hotkeys
A menu item entitled Edit Menu Hotkeys allows you to set global keyboard

equivalents for any menu item in the system-wide menu, as described in

“System-wide Menu Hotkeys” on page 27.

Preferences

'The next menu item in the system-wide menu is labeled DarkAdapted Pro
Preferences... . Select this item to open the DarkAdapted Preferences win-
dow, which is described in “Editing Preferences” on page 20.

Quit DarkAdapted
Finally, the menu item Quit DarkAdapted quits the program.

2.15 — System-wide Menu Hotkeys (Pro Only)

Pro The system-wide menu (#§) and its associated hotkeys are only
available if you have upgraded to DarkAdapted Pro, or when
you select Try DarkAdapted Pro... from the Special menu. To
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upgrade, select Register DarkAdapted Pro... from the Special
menu.

You may invoke any item in DarkAdapted Pro’s system-wide menu (@) via
global hotkeys. Global hotkeys are simply keyboard shortcuts that operate
from within any application, as long as DarkAdapted Pro is also running.

System-wide hotkeys are available when you configure the syszem-
wide menu: preference in the Preferences window to either “Show”

or “Hide, but enable hotkeys” as described on page 23.
Edit Menu Hotkeys Window

You may set system-wide hotkeys by selecting Edit Menu Hotkeys... from
the system-wide (#§) menu. When you do so, the Edit Menu Hotkeys win-

dow appears, as pictured below:

r " 3
Ne Edit Menu Hotkeys
Menu Command Hotkey
Preset Sets -> All Displays 80% < none >
Preset Sets - All Displays 90% < none >
Preset Sets -> All Displays 100% < none >

Cmd + Cntrl + Shft + E

< none >
Presets -> Red < none >
Presets -> Orange < none >
Presets -> Yellow < none >
Presets -> Green < none >
Presets -> Blue < none >
Presets -> Violet < none >
Presets -> New Preset < none >
Presets -> Full Brightness < none >
Presets -> Full Red < none >

(" EditSelection... ) ( Clear Hotkey ) (

Discard ) ( Save )

Edit Menu Hotkeys Window

'The scrolling listing contains two columns: Menu Command and Hotkey. The
Menu Command column displays every menu item available in the system-
wide menu, along with the associated hotkeys in the Hozkey column.

Setting and editing hotkeys will be covered below.

If you have one or more hotkeys set up, and would like to clear the hotkey(s)
so that no hotkey is activated for the desired menu command(s), simply click
to select one or more entries in the scrolling list, then click the Clear Hotkey
button.

'The Discard button, when clicked, closes the Edit Menu Hotkeys window
without saving any changes you may have made to the hotkeys. Click the Save
button to save the hotkeys and close the window.

To set or change a menu command’s hotkey, do one of two things:

* Select the menu command in the scrolling listing, then click the Ediz
Selection. .. button, or

* Double-click the desired menu command in the scrolling listing.
Set Menu Hotkey Window

Once you perform one of the above actions, the Set Menu Hotkey window
opens, as illustrated below:

To set the hotkey, press the desired modifier key(s) (COMMAND, OPTION,
SHIFT, and/or CONTOL) and the desired hotkey now.

Current Hotkey for "Presets -> Full Brightness”

Command + Shift + F6

(,‘ Cancel

) o)

Set Menu Hotkey Window

'This window reminds you of which menu command you are currently editing
in the display region that begins Current Hotkey for, followed by the system-
wide menu name. When the menu item is a submenu, its parent menu comes
first, followed by “->” and the menu item itself.

To set a hotkey, press and hold the desired modifier keys (88 command], [{} shitt
, and/or ), then — while still holding down the modifier keys —
press the desired non-modifier hotkey.

Almost any non-modifier key may be selected, including function keys.
Furthermore, function keys do #nof require that a modifier key also
be pressed, although you may add modifier keys if you wish. So, for
example, a hotkey of only [Fs] may be specified, as well as ,
, etc.

Page 28 — DarkAdapted User Guide



Note that the numeric keys that appear above the letters on your key-
board are 7ot the same as the numeric keys on your numeric keypad. This
gives you greater flexibility in defining hotkeys.

After you have pressed the desired key combination, release the keys and
observe the state of the red text display, which should correspond to the keys
you just typed. When you are satisfied with your hotkey, click the OK button
to close the Set Menu Hotkey window and return to the Edit Menu Hotkeys
window. Click Cancel to close the window without changing the hotkey.

2.16 — Setting Brightness Hotkeys (Pro Only)

Pro  'The brightness hotkeys are only available if you have upgraded to
DarkAdapted Pro, or when you select Try DarkAdapted Pro...
from the Special menu. To upgrade, select Register DarkAdapted
Pro... from the Special menu.

You may brighten or dim the selected screen(s) via global hotkeys. Global
hotkeys are simply keyboard shortcuts that operate from within any applica-
tion, as long as DarkAdapted Pro is also running.

You may set up brightness hotkeys by selecting Edit Brightness Hotkeys...
from the system-wide menu (). The Edit Brightness Hotkeys window then
appears, as depicted below:

~ N N

Edit Brightness Hotkeys

Hotkey to Dim Selected Screen:

F1l
Set Hotkey... : ‘ Clear
Hotkey to Brighten Selected Screen:
F2
Set Hotkey... : ‘ Clear ‘
Step: 2.0 r:] [ Percent ( Discard ) ( Save \

Edit Brightness Hotkeys Window

The Step: control at the bottom of this window defines the number of bright-
ness steps that DarkAdapted Pro uses when dimming or brightening the

display(s). The number may be adjusted between 1 and 20 via the arrow con-
trols. A Step: of 1 produces a brightness change of about 0.4% per keypress,
while a Szep: of 20 produces a change of about 7.8%.

To instead specify that brightness is adjusted in percentage steps, simply click
to select the Percent control, and DarkAdapted Pro will adjust the brightness
in the percentage step that you specify.

Unlike DarkAdapted Pro’s other hotkeys, the brightness hotkeys
repeat when you hold them down. The screen will continue to
change in brightness until you release the brightness hotkey.

To set a hotkey for brightening or dimming the display(s), click the Sez
Hotkey... button in the controlling region matching the desired action
(Hotkey to Brighten Selected Screen or Hotkey to Brighten Selected Screen). When
you click one of these buttons, the Set Brightness Hotkey window appears,
as illustrated below:

To set the hotkey, press the desired modifier key(s) (COMMAND, OPTION,
SHIFT, and/or CONTOL) and the desired hotkey now.

Current Hotkey for Increasing Brightness:

Control + F15

( Cancel

) € o)

Set Brightness Hotkeys Window

'The text display that begins with “Current Hotkey” reminds you which bright-
ness hotkey you are editing. The red text displays the current brightness
hotkey, if any.

To set a hotkey, press and hold the desired modifier keys (88 command], [£F shif] ,
and/or ), then — while still holding down the modifier keys —
press the desired non-modifier hotkey.

@ Almost any non-modifier key may be selected, including function keys
and many other keys on the extended keyboard. Note that the numeric
keys that appear above the letters on your keyboard are 7o the same as
the numeric keys on your numeric keypad. This gives you greater flex-

ibility in defining hotkeys.

After you have pressed the desired key combination, release the keys and
observe the state of the red text display, which should correspond to the keys
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you just typed. When you are satisfied with your brightness hotkey, click
the OK button to save your new hotkey and return to the Edit Brightness
Hotkeys window. Click the Cance/ button to close the Set Brightness Hotkey
window without changing the brightness hotkey.

'The brightness hotkeys will apply to whatever display you have selected using
the Display Control command of the system-wide menu (i), or — if the
system-wide menu is not showing — the following displays:

* The main display when Control Displays Independently (in the Edit
menu) is selected.

* All displays when Control Displays Independently (in the Edit menu) is
not selected.

Click Save in the Edit Brightness Hotkeys window to save your brightness
hotkeys and close the window. Click Discard to close the Edit Brightness

Hotkeys window without saving any changes you may have made.

2.17 — Running AppleScripts (Pro Only)

Pro  AppleScript execution is only available if you have upgraded to
DarkAdapted Pro, or when you select Try DarkAdapted Pro...
from the Special menu. To upgrade, select Register DarkAdapted

Pro... from the Special menu.

AppleScript Location

DarkAdapted Pro looks for AppleScripts (with the .scpt extension) in a
folder named AppleScripts, which must reside in the same folder that
contains DarkAdapted Pro. DarkAdapted Pro also looks for AppleScripts
in the startup disk = Library = Scripts = DarkAdapted Pro
Scripts folder.

When one or more AppleScripts are located in one of these folders, a menu
item named AppleScripts appears in the system-wide menu (). You may
execute any AppleScript, from within any application, by selecting its name
from the AppleScripts submenu.

You may also define hotkeys that execute your preferred
AppleScripts system-wide. Setting hotkeys for system-wide menu
items is discussed in “System-wide Menu Hotkeys” on page 27. You
may also schedule AppleScripts that run at the times you specify, as
described in “Scheduled Event Execution” on page 30.

2.18 — Independent Display Control (Pro Only)

Pro  Independent display control is only available if you have upgraded
to DarkAdapted Pro, or when you select Try DarkAdapted Pro...
from the Special menu. To upgrade, select Register DarkAdapted

Pro... from the Special menu.

By default, DarkAdapted controls all monitors using a single Control window.
To instead use separate Control windows to control multiple monitors, select
Control Displays Independently from the Edit menu (or type [$8 command|[D] ).
This will open multiple windows, one for each connected display.

When in independent display mode, the Control Displays Independently
menu item appears with a check mark next to it.

If DarkAdapted Pro is set to 7oz control displays independently,
and a scheduled event specifies that a gamma fade should apply
to a specific display, DarkAdapted Pro will automatically enable

independent display control before executing the event.

DarkAdapted Pro saves the state of independent display control across
launches.

2.19 — Scheduled Event Execution (Pro Only)

Pro  Scheduled event execution is only available if you have upgraded
to DarkAdapted Pro, or when you select Try DarkAdapted Pro...
from the Special menu. To upgrade, select Register DarkAdapted

Pro... from the Special menu.

What is Scheduling?

Scheduling references DarkAdapted Pro’s ability to perform actions (termed
“events”) at specific times. You may schedule the following types of events:

* Run an AppleScript
* Implement a Gamma Preset
* Implement a Custom Gamma Color

Many users desire gamma changes and AppleScript execution that oper-
ates on a schedule. For example, a planetarium operator may desire that
DarkAdapted Pro dim the screen at the beginning of a show, or an air traffic
controller may wish to brighten the screen at sunrise.
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Setting Up Scheduled Events

DarkAdapted Pro provides a flexible event scheduling mechanism, which is
accessed via the Scheduling window. The window may be activated by select-
ing Scheduling... from the Edit menu, or by typing [8 command][G], in which

case the Scheduling window appears, as illustrated below:

fe00 Scheduling

Name Days Time Preset/Script Color  Displays
Planetarium Show Begins M-W-F 07:00:00 pm Full Red [E===] Al Displays
Planetarium Show Ends -M-W-F- 08:00:00 pm Full Brightness ] Al Displays
Sunrise Adjustment SMTWTFS Sunrise Full Brightness [C_—_] Al Displays
Sunset Adjustment SMTWTFS Sunset (none) /1 au Displays

 E—

New Event...
¥ Enable Scheduled Events [ Display 24-hour Time ( cancel ) ok

Scheduling Window
'The control labeled Enable Scheduled Events specifies whether DarkAdapted

Pro should execute any events you have defined. When the control appears
with a check mark, DarkAdapted Pro adjusts gammas according to your pre-

defined schedule. To prevent scheduled events from executing, click to remove
the check mark from Enable Scheduled Events.

Click to select Display 24-hour Time to display the time values in the
Scheduling window and Edit Event window in 24-hour time, rather than am/
pm time format. This control only affects the display of time, not the time of
scheduled events.

All events you have defined will appear in this window’s scrolling display.
You may select an event by clicking on the entry, or select multiple events by
clicking while holding down your system’s multiple-selection modifier key.
You may also drag selected events up and down in the listing, which aftects
the order in which events execute if the events execute at the exact same time.

When one or more events are selected you may delete the selected event(s)
by clicking the Delete... button. The events will be deleted after you confirm
your decision in a dialog box, although you may skip the warning by holding
down the key while clicking Delete. .. .

To make a copy of the selected event, click the Duplicate button. The copy
appears with a period and a number at the end, and is selected in the sorted
list. You may then edit the copy as necessary.

You may edit an event by selecting a single event, then clicking the Edir...
button. You may also edit an event by double-clicking on the event in the
scrolling listing.

Creating and Editing Events

You may create a new event at any time by clicking the Scheduling window’s
New Ewent... button, in which case the Edit Event window appears, as illus-
trated below. The Edit Event window also appears when you edit an existing
event.

Event Name:

| Planetarium Show Begins

Execute on Days:

Msun MMon [1Tue Mwed [1Thu MFri [ ]sat

On Off

Event Time:

| Time of Day ' 3’!

07:00:00 . pm [ |24-hour

Event Details:

(®) Gamma Change  (7) Run AppleScript

Presets: | Full Red 4] [select by Name

Gamma Color: E] R 255 (2] ¢ offl B o2
Affects Display/Monitor: | All Displays f 3}
~ Cancel ( OK )

Edit Event Window

Type a descriptive name for the event in the Ewvent Name: text entry field.
DarkAdapted Pro will warn you if you attempt to add an event with the same
name as an existing event.
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Scheduling Events on Specific Days of the Week

The Execute on Days: controls allow you to specify the days of the week that
your event should execute. DarkAdapted Pro requires that you select at least
one day of the week in order to save the event.

Execute on Days:

#sun MMon MTue W wed .‘;,Thu Wi @ sat

On (0 ftoion: =

Click the On control to select all days of the week; click the Off control to
deselect all days. Drag either control over one or more days of the week to
apply the desired action to every day of week control that you drag over.

@ Dragging the On or Off control to the desired day(s) of the week
eliminates repetitive mouse-clicking, which is especially useful if
you are defining several events. For example, to select only the
weekend days (Sunday and Saturday), click Oz to select all of the
days (if necessary), then drag the Off control across the weekdays
to turn them off.

Setting the Event’s Time of Day

'The Ewent Time: region is where you specify the time of day that the event
should execute. From the pop-up menu, you may select Time of Day, Sunrise,
or Sunset.

Event Time:

e .00 4
AL CECNE N  07:00:00
Sunrise
Sunset

pm [ 24-hour

* When Time of Day is selected, a control appears wherein you may adjust the
hour, minute, or second of the event. If you select 24-hour, the time will be
displayed in 24-hour format; when deselected, you may also click to adjust
the am/pm indicator. When you click on the hours, minutes, or seconds
region of the control, it becomes editable. You may then type a new value,
or use the arrow controls to adjust the value upward or downward. You may
also press the key to move between all editable values and the Event
Name text entry field.

| Time of Day
Sunrise

—

Offset: 0 mins. . l Location... ‘

* When you select either Sunrise or Sunset, two controls appear. One is labeled
Offset, and specifies how many minutes before or after sunrise/sunset the
event should occur. You may adjust the Offsez up or down by means of the
arrow controls. So, for example, to define an event that will execute 30
minutes before sunset, select Sunset from the pop-up menu, then click the
“down” arrow control until the Offsez reads “~30” minutes. The Offser may be
adjusted in one-minute increments, with a minimum of —60 and maximum
of 60 minutes. The Location control is explained below.

When you define an event as occurring based on sunrise or sunset time,
DarkAdapted Pro requires your location on Earth in order to provide accurate
times. If you have never specified your location, the Location window appears
the first time you select Sunrise or Sunset from the pop-up menu. Thereafter,
you may click the Location... button to change your location. The Location
window is depicted below:

r - 1
Location
Longitude: 090 ° 31 ' West &
Latitude: 45 ° 01 ' North &

CMT Offset: 6 @ Obtain from Computer

( g Cancel

Location Window

Your longitude and latitude may be obtained from an atlas, or via the Internet.
Longitude is expressed in degrees and minutes; select West from the pop-up
menu if your location is west of the Greenwich meridian (longitude increases
as you move westward), or select East if your location is east of Greenwich
(longitude increases as you move eastward).

Latitude is also expressed in degrees and minutes. Select Nor#h from the pop-
up menu if your location is north of the equator; otherwise, select Souzh.

GMT' Offset is the number of hours that your time zone differs from
Greenwich Mean Time. This value will change throughout the year if you
observe daylight saving time. In most cases, it is best to select Obzain from
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Computer. You may also click to deselect Obtain from Computer and choose
your offset manually from the pop-up menu, but be aware that choosing a
manual adjustment will not automatically compensate for daylight saving
time, if observed in your locale.

Click OK to save your changes, or Cance/ to discard them. If no valid location
is specified, the Event Time pop-up menu in the Edit Event window changes
back to Time of Day. Closing the Location window returns you to the Edit
Event window.

Specifying a Gamma Change Event

'The Edit Event window’s Event Details: region allows you to specify either a
Gamma Change event or a Run AppleScript event.

Event Details:

@ Gamma Change O Run AppleScript

Presets: | Full Red 141 [Select by Name

Gamma Color: E] R: 255 ':“ G: 0(:1 B: 0

(&)
v

-

Affects Display/Monitor: | All Displays

Event Details Region with Gamma Change Selected

If you wish DarkAdapted Pro to change the screen gamma at the speci-
fied time, click to select Gamma Change. 1f you would like to execute an

AppleScript at the specified time, click to select Run AppleScript.

When you select Gamma Change, you may then specify the gamma color that
will be applied to the desired screen(s) when the event executes. You may
select an existing preset via the Presets: pop-up menu, select a color using the

Mac OS X Color Picker dialog (by clicking on the colored square), or define

custom red, green, and blue values (using the up/down arrow controls).

Clicking Select by Name forces DarkAdapted Pro to select the gamma color
by its Preset name. This can be useful if you plan on replacing a preset (in the
Edit Presets window) with one that has an identical name, but different color
values. This saves the effort of redefining your events with different colors.

In most cases, however, it is best to leave Select by Name unchecked.

If you delete a preset that is used by one or more scheduled events,
DarkAdapted Pro will still be able to set the screen gamma to the

deleted preset’s former values, unless you check the Select by Name
option. This is why it’s best to leave Se/ect by Name unchecked.

If you would like your event to control all monitors in unison, select A/
Displays from the Affects Display/Monitor: pop-up menu. To instead control
only a single monitor, select the display number from the pop-up menu.
Specifying an AppleScript Event

When you select Run AppleScript in the Event Details: region, a different set
of controls appears here, as illustrated below:

Event Details:

(1) Gamma Change () Run AppleScript

<

AppleScript: ".ﬂF;IAirgriightness.scpt

E‘ Run this AppleScript only at the specified minute

Ewvent Details Region with Run AppleScript Selected

Select an AppleScript to execute at the specified time by selecting the script’s
name from the AppleScript: pop-up menu.

Q DarkAdapted Pro populates the AppleScript: pop-up menu with
all of the AppleScripts (with the .scpt extension) it locates in a
folder named AppleScripts, which resides in the same folder
that contains DarkAdapted Pro. DarkAdapted Pro also looks for
AppleScripts in the startup disk = Library = Scripts 2
DarkAdapted Pro Scripts folder.

'The list is updated every time you open the Edit Event window, so
you may add, change, or remove AppleScripts while DarkAdapted

Pro is running.

The control captioned Run this AppleScript only at the specified minute lets
you specify what happens if the machine is off or in sleep mode — or
DarkAdapted Pro is not running — when an AppleScript is scheduled to run.

If you click to select Run this AppleScript only at the specified minute, Dark-
Adapted Pro will not run the AppleScript unless DarkAdapted Pro is run-
ning and your machine is “awake” at the scheduled execution time. When the

control is 7oz selected, DarkAdapted Pro will run the AppleScript (if it is the
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most recent scheduled event) when the machine returns from sleep mode or

DarkAdapted starts up.

Save or Discard Event Changes

To save the changes you made in the Edit Event window, click the OK but-

ton, and the window closes. To close the window without saving changes,
click Cancel.

Cancel ( OK >’

Events in the Scheduling Window

The various columns in the Scheduling window begin with Name, which
is simply the name you specified for the scheduled event in the Edit Event
window.

e 00 Scheduling

Name Days Time Preset/Script Color  Displays
Planetarium Show Begins M-W-F 07:00:00 pm Full Red [E===] Al Displays
Planetarium Show Ends -M-W-F- 08:00:00 pm Full Brightness 1 Al Displays
Sunrise Adjustment SMTWTFS Sunrise Full Brightness C_ an Displays
Sunset Adjustment SMTWTFS Sunset (none) [1 Al Displays

 m——

New Event...
¥ Enable Scheduled Events [ Display 24~hour Time Cancel ( ok )

Scheduling Window

The Days column provides a visual representation of the days of the week
on which the event will execute. Each entry in this column consists of seven
characters, one for each day of the week, starting with Sunday and ending
with Saturday.

If a scheduled event will execute on a particular day of the week, the first let-
ter of the day’s name appears; otherwise, a hyphen (“=”) appears. So, an entry
in the Days column of “§------ ” denotes an event that occurs on Sunday
only; the entry “SMTWTFS” indicates that an event occurs every day; and an

entry reading “---W-F-" denotes an event that occurs only on Wednesdays

and Fridays.

'The Time column will display either the event’s time of day, or that the event
occurs at sunrise or sunset. If an event specifies sunrise or sunset, the offset (if
any) in minutes appears here also.

The column titled Preset/Script denotes the AppleScript name or the gamma
preset associated with the event, if any. If the gamma value was specified
manually in the Edit Event window, the text “(none)” appears instead of
the preset’s name.

The column labeled Color displays different values, according to the type of

event scheduled, as described below:

* For scheduled events that specify a gamma change, Color displays the

color that will be applied to the screen(s) when the event executes.

* For gamma change events that specify Se/ect by Name, the Color col-
umn contains the text “ (name)”.

* For events that schedule an AppleScript, the Co/or column is blank.

'The Displays column indicates which display(s) will be aftected by the sched-
uled gamma change event when it executes. For AppleScript events, the
Displays column indicates “ (script)”.

To save changes to the listed events, click the OK button, which also closes
the Scheduling window. Clicking Cance/ closes the window, discarding any
changes made since the Scheduling window last opened, including any
changes made in the Edit Event window.

When first launching DarkAdapted Pro or closing the Scheduling
window — and when scheduled events are enabled — DarkAdapted
Pro checks to see which “past” event should be active, and imple-
ments that event.

When you select a single event in the list, its next scheduled execution appears
below and along the right edge of the events listing.

Event Errors

As described above, scheduled events can reference gamma changes by
color or by Preset name. If you specify that DarkAdapted Pro should select
a gamma change based on its name — and if that Preset has been renamed
or deleted — DarkAdapted Pro will alert you to this when opening the
Scheduling window.
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Additionally, if you have set up a scheduled event that executes an AppleScript
— and that AppleScript has been moved, renamed, or deleted — then
DarkAdapted Pro will also report this when opening the Scheduling window.

'The error dialog that appears when DarkAdapted Pro detects missing Preset
name(s) and/or AppleScript(s) is illustrated below:

Preset Not Found.

Sorry, DarkAdapted attempted to access a preset named
“Yellow," but there is no longer a preset with that name.

L

Additionally, 3 other Presets and/or AppleScripts were not
located. Events with errors are selected in the Events listing.

(—ok—)

Missing Preset(s) and/or AppleScript(s) Warning

'The dialog appears when opening the Scheduling window, and specifies the
first error by the missing Preset’s or AppleScript’s name. All entries in the
scrolling listing that contain errors are then highlighted for your inspection.

When Do Events Execute?

When your system is running, not in sleep mode, and DarkAdapted is run-
ning, events occur within one second of the time that they are scheduled to
execute.

Sleep mode and system shutdowns can obviously interfere with scheduled
event execution. This and other event execution details are summarized below:

* When your system returns from sleep — or DarkAdapted Pro resumes for
any other reason — DarkAdapted Pro first determines whether any events
have been “missed” during the time that DarkAdapted Pro was suspended.
If no events were scheduled to run during that time, there is no need to do
anything except wait for the next event to execute.

* If DarkAdapted Pro detects that events should have occurred since the last
time it updated, the program clears its memory of a// scheduled events. Then,
it creates a list of future events that will execute later. DarkAdapted Pro also
determines which event should be active right now, which is the most recent
scheduled event, and that event is executed immediately.

* An exception to this behavior is a “Run AppleScript” event with the
parameter Run this AppleScript only at the specified minute selected. Since
this parameter specifies that a “missed” AppleScript should 7oz run,
DarkAdapted Pro will discard this expired event if it was set to occur more
than 60 seconds ago.

If DarkAdapted Pro discards an expired event as described above, then the
program continues to look backward in time, implementing the most recent
event it finds that also is allowed to execute late (that is, any event except
an AppleScript event with the parameter set to Run this AppleScript only at
the specified minute).

DarkAdapted Pro normally checks its event listing once per minute, unless it
determines that an event is scheduled to occur within the next two minutes.
In that case, DarkAdapted Pro prepares to execute the event, checking the
system time more and more frequently as the event time moves closer to
zero. This minimizes cpu usage, while still allowing events to execute with
1- or 2-second precision.

* If more than one event is scheduled for the exact same time, DarkAdapted
Pro executes the events in the order by which they appear in the Scheduling
window.

2.20 — Internet Update Checking

DarkAdapted is able to check for newer versions, provided you have an active
Internet connection.

Many error messages are the result of an inactive Internet connec-
tion. Make sure you are connected to the Internet before attempt-
ing to use DarkAdapted’s Internet update checking.

To check for newer program versions, select Check for Program Updates...
from the File menu.

If no update is required — DarkAdapted will present a dialog confirming that

you are already up-to-date. If DarkAdapted determines that a newer version is
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available, the Update window opens, as depicted below:

006

Beta Release Notes:

Version 2.0b5 is on the Update Server

Statistics for Your Version and Update Server's Version.

2.0b5, Build 147
2.0b5, Build 147

Your version:
Server's version:

e e R e e e T

— — T,
keys, in addition to the hotkey.

+ Mac: Worked around some errors in the compiler regarding Applescript on some Intel Macs. If you
continue to experience problems with an Applescript, please let me know if you would be willing to try
a version that creates a debugging file.

+ Windows: Added Donate window, accessible via the Special menu. A
a Mar: Imnlamantad Danictratinn Windnw Raraiica tha Mar hata Frurranths hahavac ac if it wara >4
( Cancel ) (" GotoDownloads Page ) Download 2.0b5 B

Update Window

Near the top of this window are listed the Version and Build Number for the
currently-running copy of DarkAdapted (“Your Version:”) and for the Newer
Version: available via the Internet.

The scrolling list may contain the latest changes in the new version, special
instructions, program news, etc. The Copy command in the Edit menu may be
used to transfer this text to another program.

Click the Download Newer Version button (at the bottom-right corner of the
Update window) to begin the download. A standard dialog will appear, where
you may select the download destination and optionally change the down-
load’s name.

Once the download begins, the two buttons Go 0 Downloads Page and Down-
load Newer Version will disappear, replaced by a download progress display
which reports the download’s status both numerically and graphically.

During a download, the Cance/ button serves to terminate the download and
close the window, after a warning dialog. When no download is in progress,
clicking Cancel simply closes the Update window.

Click the Go to Downloads Page button to open your default web browser and
display DarkAdapted’s downloads page.
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When you click the Download Newer Version button, the version of
DarkAdapted that matches your platform (Mac OS X or Windows) is au-
tomatically selected for download. To instead download DarkAdapted for a
different computing platform, right click (Mac: control-click) in a blank area
of the Update window to summon the window’s contextual menu, as shown
below:

Download Mac OS X Version 2.0b5
~=  Downlbad Windows Version 2.0b5

Update Windows Contextual Menu

Select the desired version from the menu, then download the file to the de-
sired location.

After successfully downloading an update, DarkAdapted instructs you to quit
the program, expand the archive, and launch the new version to complete the
update process.

@ You may force the Update window to show — even if a newer
version is not available — by holding down the or key
while you select Check for Program Updates... from the File
menu. In such cases, some of the text in the Update window will
change, and the Download Newer Version button’s name will change
to reflect the update server’s version.

2.21 — Custom System-wide Menu Icon (Pro Only)

Pro  'The system-wide menu is only available if you have upgraded to
DarkAdapted Pro, or when you select Try DarkAdapted Pro...
from the Special menu. To upgrade, select Register DarkAdapted
Pro... from the Special menu.

DarkAdapted Pro normally displays a small DarkAdapted icon (i§) to rep-
resent the system-wide menu. Experienced users may change this icon to, for
example, match a particular menu bar theme.

When launching, DarkAdapted Pro checks for a folder named “CustomIcon”
(without the quotation marks) in the same folder as DarkAdapted Pro. It
checks for the following two files inside the “CustomIcon” folder:

* DAIcon
* DAMask




These two files should each be 16 pixels wide by 16 pixels high, and may
include an extension (such as .jpg). If QuickTime is installed on your sys-
tem, DarkAdapted Pro can read most graphics formats. If QuickTime is not
installed, only p1cT files are supported.

'The “DAlcon” file should contain your graphic of choice. The “DAMask” file
should contain white pixels for any region that should be transparent, and

black pixels for any region that should be visible.

Here are sample “DAlcon” and “DAMask” files — greatly enlarged — that
represent the standard DarkAdapted Pro icon:

DAlcon DAMask

Here is a simple example of a “ball” icon:

Qe

DAlcon DAMask

Make sure that your images are exactly 16 pixels wide and high, that they are
in a format that DarkAdapted supports, that you have named the files cor-
rectly (including the correct file extension), and that they are in the proper
location, with a properly-named parent folder.

2.22 — Shared Preferences (Pro Only)

Pro Manually reading and writing the shared preference file is only
available if you have upgraded to DarkAdapted Pro, or when
you select Try DarkAdapted Pro... from the Special menu. To
upgrade, select Register DarkAdapted Pro... from the Special

menu.

DarkAdapted normally reads from and writes to your user preferences file.
It can also be instructed to read from or write to the shared preferences file.

Q The user preferences file is located at:
~/ Library / Preferences / DarkAdapted Preferences

where “~” is your home directory.

The shared preferences file is located at:

*/ Library / Preferences / DarkAdapted Preferences

W .

where “”is your startup disk.

If you would like to share your current DarkAdapted preferences with other
users on the same machine, simply select Save Shared Preferences... from
DarkAdapted’s Special menu.

Then, when you are running DarkAdapted while logged in as a different
user, select Load Shared Preferences... from DarkAdapted’s Special menu.
'The shared preferences file will load, and will replace all of DarkAdapted’s

configurable settings.

When you are logged in to a non-administrator’s account, you will
need to enter an administrator’s password to save the shared prefer-
ences file.

If DarkAdapted cannot locate the user preferences file when you launch
the application (when, for example, you are starting it for the first time on
a particular user’s account) — and if the shared preferences file exists —
DarkAdapted will load the shared preferences file as it starts up. Thereafter, it

will continue to use the user preferences file.

2.23 — Using DarkAdapted with Display Calibrators

DarkAdapted has been designed to work well with monitor calibration sys-
tems. DarkAdapted takes your calibrated display profile into account before
applying its own gamma corrections.
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To use DarkAdapted with a display calibration device, simply quit DarkAdapted

before running your display calibration routine.

Running DarkAdapted while calibrating will produce unsatisfactory
results, because most calibration routines reset the screen gamma
throughout the calibration process.

'Therefore, the best solution is to quit DarkAdapted, calibrate your display(s),
then re-open DarkAdapted. DarkAdapted will then make gamma modifica-

tions relative to your calibrated monitor profile.

When reducing brightness using DarkAdapted, most displays will
maintain color fidelity down to about 60-75% brightness. This varies
based on display characteristics.

Section 3:
AppleScript Guide

3.1 — Introduction

Mac This section applies only to users running DarkAdapted for Mac
OS X or Mac OS Classic. If you are using DarkAdapted for
Windows, you may skip this section.

Pro  Inaddition to its support of AppleScript control, DarkAdapted Pro
adds the ability to schedule AppleScript execution, as described in

“Scheduled Event Execution” on page 30.

DarkAdapted features extensive AppleScript support, allowing you to control
almost every program feature and setting. This enables automated control of

DarkAdapted from other programs or simple AppleScripts.

Additionally, you may obtain information concerning the current screen
gamma, and store/retrieve preference settings.

A sample AppleScript is included with the standard DarkAdapted download.

3.2 — Command Reference

'The following tables summarize DarkAdapted’s AppleScript support. In the
examples, the “~“ character indicates that the script’s line wraps to the follow-

ing line; do not include the “~ character in your script.

Command: activate
Syntax: activate
Function: Launches DarkAdapted if it is not already running, and brings the Control
window to the front of the window layering order.
Example: tell application "DarkAdapted"
activate
end tell
Command: quit
Syntax: quit
Function: Quits DarkAdapted if it is running.
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Example: tell application "DarkAdapted" Function: Specifies whether DarkAdapted Pro should control all displays in unison,
quit or each display independently. Specify true to control displays inde-
end tell pendently, with a separate Control window for each display, or false to
control all displays in unison, controlled by a single Control window.
Command: savePreferences DarkAdapted Standard simply ignores this command; it only works with
DarkAdapted Pro.
Function: Saves all of DarkAdapted’s preference values, and the current gamma
preset(s) or color values, for possible restoration with the restorePref- Examples: tell application "DarkAdapted"
erences command. independentDisplayControl true
independentDisplayControl false
Example: tell application "DarkAdapted" end tell
savePreferences
end tell
Command: selectDisplay (DarkAdapted Pro only)
Command: restorePreferences Syntax: selectDisplay [parameter]
Syntax: restorePreferences [parameter] Parameters: | An integer corresponding to one of your connected displays. Specify
0 for the main display, 1 for the second display, and so on.
Parameters: with restoringGamma or without restoringGamma
Returns: boolean
Function: If savePreferences has previously been called, all of DarkAdapted’s
preference values are restored to their saved values. Use with restor- Function: Set the desired display to control via subsequent AppleScript commands,
ingGamma to also restore the saved gamma setting(s) (or the saved entering Independent Display Mode if necessary. If you specify a nonexis-
preset(s), if selected). tent display, the closest valid display is selected.
Notes: restorePreferences has no effect if savePreferences has not Setting the display to 1 or higher enables Independent Display Mode, if
previously been called. necessary.
If you specify with restoringGamma, the most recently stored This function returns false ifa none.xistf:nt display is sPeciﬁFd, in V&{hich
gamma setting or preset is restored. If the gamma has never been stored, it case DarkAdapted selects the closest valid display. Otherwise this function
. returns true.
remains unchanged.
DarkAdapted Standard simply ignores this command; it only works with
Examples: tell application "DarkAdapted" DarkAdapted Pro.
restorePreferences with restoringGamma
restorePreferences without restoringGamma Examples: tell application "DarkAdapted"
end tell if not selectDisplay 0 then beep
end tell
Command: | independentDisplayControl (DarkAdapted Pro only)
Command: getGamma
Syntax: independentDisplayControl [parameter]
Syntax: getGamma [parameter]
Parameters: true or false
Parameters: with percentages or without percentages
Returns: string
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Function: Retrieves the gamma settings for the currently selected display in a comma-
delimited string.

If with percentages is passed, the values are returned as percentage
values, including tenths of a percent.

If without percentages is passed, values are returned in the range
0-255.

The returned values represent the gamma’s red, green, and blue components,
respectively.

Examples: tell application "DarkAdapted"

if not setGamma preset "Full Brightness"-—
then return -- sets the gamma to 100%
display dialog getGamma with percentages-—
-- displays "100.0,100.0,100.0"
display dialog getGamma without percentages—
- displays "255,255,255"
end tell

Command: setGamma

Syntax: setGamma value [parameter]
or
setGamma preset [parameter]

Parameters: If using setGamma value [parameter],the parameter must be
passed as a comma-delimited string of the three integers which represent
the desired gamma’s red, green, and blue components, respectively. Each
component value must be in the range zero to 255, with 255 representing
full brightness.

If using setGamma preset [parameter],the parameter must be
passed as a valid preset name (as it appears in the Control window’s Presets:
pop-up menu).

Returns: boolean

Function: Implements a gamma fade on the currently selected display. Returns true
if an allowable value or recognized preset is received, or false if an ille-
gal value or unrecognized preset name is passed.

Notes: DarkAdapted will not allow the gamma value to be set to “0,0,0” — because
a scripting error could also result in three zero-values being passed. To turn
the screen off, use, for example, “0,0,1”

Page 40 — DarkAdapted User Guide

Examples: tell application "DarkAdapted"
if not (setGamma value "255,255,255") then-
beep -- full brightness
if not (setGamma preset "Full Green") then-
beep
end tell
Command: displayControlWindow
Syntax: displayControlWindow [parameter]
Parameters: with detailsShowing or without detailsShowing
Function: Use with detailsShowing to display the Control window at full
size,or use without detailsShowing to minimize the window.
Examples: tell application "DarkAdapted"
displayControlWindow with detailsShowing
displayControlWindow without detailsShowing
end tell
Command: gangSliders
Syntax: gangSliders [parameter]
Parameters: true or false
Function: Specifies whether or not the gamma control sliders move in unison when
adjusting one slider. Specify true to gang the gamma control sliders for
the selected display(s), or false to set the sliders to independent control.
Examples: tell application "DarkAdapted"
gangSliders true
gangSliders false
end tell
Command: maintainRelativeValues
Syntax: maintainRelativeValues [parameter]
Parameters: true or false
Function: Specifies whether or not the gamma control sliders maintain their propor-

tions of red, green, and blue. Enters Ganged Mode if necessary. Specify
true to maintain relative slider values for the selected display(s), or
false to cause sliders to lose their relative values when one slider reaches
the end of its travel.




Examples: tell application "DarkAdapted" Parameters: Any combination of two or more of the following: shift, control,
maintainRelativeValues true option, alt, command, separated by commas.
maintainRelativeValues false .

end tell Optionally, you may also pass keycode='X"' and keytext='QY'
where X references the Macintosh hardware keycode (in decimal) for the
desired key, and Y references either the character printed on the key or its

Command: restoreGammaOnLaunch ASCII value.

it restoreGammaOnLaunch [parameter] prmﬁngtheASCHIVdueJmedethevﬂuebthe @ character. You

must pass both keycode and keytext , or neither.

Parameters: true or false

Returns: boolean

Function: iieaﬁe; w}}their or 1}110t DarkAdapted should restore previous gamma set Fanction: Specifies the modifier keys, and optionally changes the non-modifier key,

gs when it is launched. Specify true to restore previous settings at - .
launch, or false to start up at full brightness. th’flt must be he.ld down in order to toggle the gamma setting between full
brightness and its last non-full value. Returns true if a successful com-

Examples: tell application "DarkAdapted" mand is received, or false if an illegal value is passed.
restoreGammaOnLaunch true . )
restoreGammaOnLaunch false Example: tel} application "DarkAdapted" .

end tell if not (toggleKeys "shift, control, option")-
then beep -- just changes modifiers, not key
if not (toggleKeys "shift, keycode='36"',-

Command: fadeSteps keytext='Q@13') then beep -- changes gamma -

toggle keys to Shift + Return

Syntax: fadeSteps [parameter] if not (toggleKeys "control, keycode='3",~

keytext='F') then beep -- changes gamma -

Parameters: 1, 15, 30, 60, 90, or 120 toggle keys to Control + F

end tell
Returns: boolean
Function: Specifies the number of steps in gamma fades. Returns true if an allow- Command: gammaToggleKeysAllDisplays (DarkAdapted Pro only)
able value is received, or false if an illegal value is passed.
Syntax: gammaToggleKeysAllDisplays [parameter]

Example: tell application "DarkAdapted"

if not (fadeSteps 15) then beep Parameters: | true or false
end tell
Function: Specifies whether or not the gamma toggle keys affect all displays, or only
the display with the frontmost Control Window. Specify true to control

Command: toggleKeys all displays with the toggle keys,or false to control only the display

with the frontmost Control Window.

Syntax: toggleKeys [parameter]

DarkAdapted Standard simply ignores this command; it only works with
DarkAdapted Pro.
Examples: tell application "DarkAdapted"

gammaToggleKeysAllDisplays true
gammaToggleKeysAllDisplays false
end tell
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Command: gammaRefreshPeriod Function: Specifies whether DarkAdapted checks for alpha or beta (“pre-release”) ver-
sions when performing an Internet update check.
Syntax: gammaRefreshPeriod [parameter]
Examples: tell application "DarkAdapted"
Parameters: Integer in the range zero to 60. updateChecking with prereleases
updateChecking without prereleases
Function: Specifies how often the screen gamma will be manually re-applied. Enter 0 end tell
(zero) to turn off gamma refreshing, or specify a period in seconds between
1 and 60.
Command: updateCheckFrequency
Example: tell application "DarkAdapted"
gammaRefreshPeriod 30 Syntax: updateCheckFrequency [parameter]
end tell
Parameters: One of the following strings: weekly or monthly or via menu
only
Command: doSliderUpdating
Function: Specifies whether and how often DarkAdapted performs an automatic
Syntax: doSliderUpdating [parameter] Internet update check for new versions.
Parameters: with trackingfades or without trackingfades Examples: tell application "DarkAdapted"
updateCheckFrequency "weekly"
Function: Controls whether sliders track gamma fades. updateCheckFrequency "monthly"
updateCheckFrequency "via menu only"
Examples: tell application "DarkAdapted" end tell
doSliderUpdating with trackingfades
doSliderUpdating without trackingfades
end tell Command: | hideSystemWideMenu (DarkAdapted Pro only)
Syntax: hideSystemWideMenu [parameter]
Command: reportGammaValues
Parameters: with hotkeysEnabled or without hotkeysEnabled
Syntax: reportGammaValues [parameter]
Function: Hides the system-wide menu, either with hotkeys enabled or without
Parameters: with percentages or without percentages hotkeys enabled
Function: Controls whether the text readouts (to the right of the gamma sliders) DarkAdapted Standard simply ignores this command; it only works with
report gamma values as percentages or as raw values. DarkAdapted Pro.
Examples: tell application "DarkAdapted" Examples: tell application "DarkAdapted"
reportGammaValues with percentages hideSystemWideMenu with hotkeysEnabled
reportGammaValues without percentages hideSystemWideMenu without hotkeysEnabled
end tell end tell
Command: updateChecking Command: showSystemiWideMenu (DarkAdapted Pro only)
Syntax: updateChecking [parameter] Syntax: showSystemWideMenu
Parameters: with prereleases or without prereleases




Function: Shows the system-wide menu and enables its hotkeys.
DarkAdapted Standard simply ignores this command; it only works with
DarkAdapted Pro.

Examples: tell application "DarkAdapted"

showSystemWideMenu
end tell

Section 4:
Troubleshooting

4.1 — Error Messages in Windows

Some versions of Windows do not automatically adjust an application’s use
of memory. If DarkAdapted exceeds the amount of ram allocated to it, the
program may display an error message, or it may crash.

If you are running DarkAdapted X under Mac OS X then this section is not
applicable.

Many error messages are memory related, so — if you frequently encounter
error messages, you may wish to allocate more memory to DarkAdapted.
Consult your computer’s documentation as to how you may allocate more
memory to an application program.

If you encounter error messages that you believe may be caused by an error
within DarkAdapted, then take careful note of any error messages that appear,
along with steps that lead to a reproducible error, and e-mail the information
to us. We'll do what we can to identify, reproduce, and correct the problem.

Make sure you have 2 mB available Ram in which to run DarkAdapted,
especially if you have added many presets or scheduled events. DarkAdapted
runs well under virtual memory and with most popular memory-doubling
technologies.

If problems persist, try restarting in “safe mode,” as described in your com-
puter’s documentation.

4.2 — My Monitor is Stuck at Reduced Brightness!

'This usually occurs if DarkAdapted or your system has crashed, leaving your
monitor’s gamma ramp in a modified state.

First off, do not panic! It’s easy to restore your monitor to full brightness.

Win Simply restart your machine to return your monitor to its default
gamma setting. If this is not effective, open your Display control panel
and click the Seztings tab. Change your Colors control to a different value
and back again. As a last resort, try reinstalling your video driver to clear
the “stuck” gamma preference.
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Mac Under Mac OS X, select System Preferences... from the Apple
menu. Select the Displays preference pane, then click on the Color
tab. Click to select a difterent Display Profile, then select the origi-
nal (or any desired) profile to reset your gamma. If this does not
work, you may have to restart your machine.

4.3 — Common Problems

Help! DarkAdapted no longer has an interface!
'This can happen only when all of the following are true at the same time:

* DarkAdapted Pro has been set to show no Dock icon (so that it has
no menu bar at the top of your screen), and

* 'The preference for the system-wide menu is Hide, and

* The preference Closing Control Window quits DarkAdapted has been
set to false (deselected), and

* The last Control window (which has a contextual menu allowing
you to set preferences or show the system-wide menu) has been
closed, and

* You have forgotten the hotkey that shows the Edit Menu Hotkeys

window.

If all of the above occur at the same time, DarkAdapted Pro warns you about
a “no interface” situation, unless you have checked Don’t show again in the
warning dialog the last time it appeared. At the very least, DarkAdapted Pro
enables system-wide hotkeys so that you can still control DarkAdapted Pro.

There are four ways out of this situation:

* Check out your “AppleScript” folder in your DarkAdapted folder
for a script named “Restore Interface AppleScript.” Run this script,
and all of DarkAdapted Pro’s Control windows will show, and the

system-wide menu will be enabled.

* Try the default hotkey for Edit Menu Hotkeys... that DarkAdapted
automatically sets up (if none is defined) when the interface disap-

pears. That hotkey is [ command] \Coption|[«]. That may open the Edit
Menu Hotkeys window. You can then set a hotkey to show the
Preferences window, and configure DarkAdapted Pro.

* If you have defined a system-wide menu hotkey for Edit Menu
Hotkeys..., and you can remember it, press that hotkey. You

can then set a hotkey for the Preferences window, and configure

DarkAdapted Pro to your liking.

* As a last resort, you can quit DarkAdapted Pro using Apple’s
Activity Monitor (or simply log out and back in), then remove the
DarkAdapted Preferences file from the Preferences folder inside the
Library folder of your home directory, and remove the DarkAdapted
Preferences file from the Preferences folder inside the Library folder
at the top level of your startup disk, then re-open DarkAdapted and

re-register.

DarkAdapted does nothing on my system.

This occurs most often with Windows-compatible machines. While
DarkAdapted functions well with many Windows systems, it cannot sup-
port all possible hardware/software combinations. Generally speaking, if your
hardware supports standard gamma change routines, DarkAdapted will work
on it.

DarkAdapted doesn’t affect some of my screen colors.

Windows does not consider white when modifying gamma values. Some
users have reported success via changing the Windows theme to the “Classic”
value.

My gamma setting is not persistent.

Most systems will reset the gamma ramp when you restart, when a screen
saver exits, or when your system sleeps and wakes. DarkAdapted will not
“know” about this event and may not reset the gamma. The solution is to
enable the Refresh gamma values control in the Preferences window.

DarkAdapted periodically shows the License Agreement window when I
open DarkAdapted.

The License Agreement window appears the first time you open a new ver-
sion of DarkAdapted. If you open an earlier version, quit that earlier version,
then open the newer version of DarkAdapted, the License Agreement win-
dow again displays.

DarkAdapted contains several presets for Red and Green; why not Blue?

DarkAdapted was developed to help preserve the user’s dark adaptation. Red

is most widely regarded as the best choice for this purpose, while green also
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has its adherents. Blue is not generally recommended to preserve dark adapta-
tion, so no presets are supplied in the blue range.

If youd like to add blue presets, check out the supplied file “Blue Presets,”
which is part of the DarkAdapted download package.

DarkAdapted does not affect all of my monitors.

Version 1.3.1 introduced multiple monitor support. If you are using version
1.3.1 or later, make sure you remove any prior versions of DarkAdapted, then
restart your system to enable control of all connected displays.

I upgraded to DarkAdapted Pro, but the menu still reads “DarkAdapted.”

Apple recommends against an application modifying the files that
DarkAdapted would need to change in order to change the menu text. That is
why we have added “DarkAdapted Pro” to the lower-left corner of all Control
windows, to the About menu items, and to each Control window’s title.

DarkAdapted does not present the option “Try DarkAdapted Pro...”

If you are already trying DarkAdapted in Pro mode, this menu item will be
unavailable. Note also that DarkAdapted Pro is only available to users run-
ning Mac OS X.

DarkAdapted does not present the option “Register DarkAdapted Pro...”

If you have already registered DarkAdapted Pro, this menu item will be
grayed-out.

If you are running Windows, note that DarkAdapted Pro is only available to
users running Mac OS X, and so this command does not appear in Windows.

Scheduled events occur at unexpected times.

When you have enabled scheduling via the Scheduling window, Dark-
Adapted Pro checks for scheduled events when it is first opened, when you
close the Scheduling window, and when the computer exits sleep mode. At
those times, DarkAdapted Pro checks to determine which event has occurred
most recently, and implements that event.

An exception to the above behavior occurs with AppleScript scheduling. If
you have selected Run this AppleScript only at the specified minute in the Edit
Event window, then DarkAdapted Pro will not implement the AppleScript
if the machine is in sleep mode during the minute that the AppleScript is
scheduled to execute.

If you have not selected Run this AppleScript only at the specified minute, then
any AppleScripts that were scheduled to occur while the machine was in
sleep mode will also be skipped, un/ess the most recent missed event is an
AppleScript event, in which case the last missed event executes.

I receive error messages when I open the program.

If you are running DarkAdapted on an earlier version of Windows (prior to
Windows XP), then the first issue you should suspect is a memory problem.
Try allocating more memory to DarkAdapted as described in your computer’s
documentation or on-line help system.

It is also possible that the file “DarkAdapted Preferences” has become dam-
aged. In Mac OS X, “DarkAdapted Preferences” is located in the active User’s
“Library” folder, in the “Preferences” folder. In Windows, the file is located in
the same directory as DarkAdapted.

'The preferences file must remain unlocked and in place while you use the
program; otherwise, DarkAdapted will be unable to write preference informa-
tion, and an error message will be generated.

I receive error messages when I quit the program.

See the above discussion concerning the file “DarkAdapted Preferences.” Your
startup disk must be writable (i.e., it cannot be a cD or other read-only medi-
um). Otherwise, DarkAdapted will be unable to save preference information
when you quit the program, and an error message will appear.

I receive error messages while using the program.

If DarkAdapted reports an error while you are using the program, one of the
tollowing is likely to be true:

* The program has run out of application memory. There isn’t enough
memory to store additional data or display a graphic. This should not occur
when running DarkAdapted X under Mac OS X, because Mac OS X
dynamically allocates memory to application programs. Windows XP and
later also dynamically allocate memory.

* The program has attempted to write data to a disk that is locked or read-
only. This may occur when saving a file, when the program writes to its
preferences file, or when writing temporary files to disk.

* The program has attempted to access a file that has been moved or deleted
since DarkAdapted last attempted to read from it.
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* The program contains an error that causes results that have not been antic-

ipated (a “bug”).

Make sure also that DarkAdapted and its support files are installed on an
unlocked disk, and that you have started your computer from an unlocked,
writable startup disk.

If you believe you have found a bug in the program, let us know! DarkAdapted
contains many thousands of lines of programming code, and it is unrealistic
for us to expect that we have anticipated every possible situation. If the situ-
ation is repeatable, please outline the steps that are required to reproduce the
problem. Support information is described in the following Section.

4.4 — Technical Support

Consult the “Read Me” file in the Documentation folder — or click the link
in DarkAdapted’s Control window — for technical support contact informa-
tion.

You may also select Send E-mail... from the Special menu to send us a mes-
sage using your default e-mail client.

Additional information is available at the DarkAdapted web site.
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http://www.aquiladigital.us/darkadapted/index.html
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